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Your Feedback Is Important

Your feedback helps us improve our documents to better serve youl

Please take a few minutes to evaluate your experience using this
document.

Product and Personal Information

1. What printer are you using?
2. What document are you using?
3. Have you ever worked with our product before? Yes No

If Yes, how many years? months?
4. What is your education level?

Document Usability

Check the rating that applies to your experience using this document:

Content Poor

Excellent ‘ Good

The information I needed was available.

The information I needed was easy to find.

The information and directions were clear.

The illustrations were helpful.

The document was arranged logically.

The Table of Contents and Index were
helpful.

The Glossary was helpful.

The level of information was appropriate
for my technical expertise.

Additional Comments

Write any additional comments on the lines provided on the next page.
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Feedback Form

Thank you for taking the time to provide us with feedback.
Fax: Attention:

> E-mail:
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Warranty Information

ZebraNete PrintServer 11

Zebrawarrantsthe ZebraNet PrintServer |1 against defectsin material or workmanship
for aperiod of three years from either (i) the date of shipment to you by Zebra, or (ii)
the date of any resale by you to an end user, whichever islater. Proof of shipment date
may be required to validate the warranty period. This warranty does not cover normal
wear and tear, and shall be null and void if the equipment is modified, improperly
installed or used, damaged by accident or neglect, or improperly installed or replaced
by the user. To qualify for this warranty, the ZebraNet PrintServer |1 must be returned
to the factory or other authorized service center.

ZEBRA’S SOLE OBLIGATION UNDER THISWARRANTY SHALL BETO
FURNISH PARTSAND LABOR FOR THE REPAIR OR REPLACEMENT OF
PRODUCTS FOUND TO BE DEFECTIVE IN MATERIAL OR WORKMANSHIP
DURING THE WARRANTY PERIOD, OR ZEBRA MAY, AT ITSDISCRETION,
ISSUE A CREDIT FOR ANY SUCH DEFECTIVE PRODUCTS IN SUCH
AMOUNT ASIT DEEMS REASONABLE.

As acondition of this warranty, the user must: (a) obtain aZebra Return Materias
Authorization (RMA), which will include an RMA number that must be prominently
displayed on the outside of the shipping container (returns without an RMA number
will be rglected by Zebraand immediately returned to you, freight collect); (b) ship the
Product being returned freight prepaid, to the authorized service location; and (c)
include with the Product a written description of the claimed defect. Products returned
should be packaged in the original packing and shipping container or comparable
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Warranty Information

container. In the event the Product is not so packaged or if shipping damageis evident,
it will not be accepted for service under warranty. Surface transportation charges for
the return of the Product to the customer shall be paid by Zebrawithin the 48
contiguous states and the District of Columbia. The customer shall pay shipping costs,
customs clearance, and other related charges outside the designated area. If Zebra
determines that the Product returned to it for warranty service or replacement is not
defective as herein defined, the customer shall pay all costs of handling and
transportation.

Warranty Exclusions and Conditions

The above warranty isin lieu of all other warranties, expressed or implied, oral or
written, statutory or otherwise, including any implied warranty of merchantability or
fitness for a particular purpose. Zebra shall not be responsible for the specific
application to which any Products are applied, including but not limited to
compatibility with other equipment. All statements, technical information, and
recommendations relating to Zebra Products are based on tests believed to be reliable
but do not constitute a guarantee or warranty.

ZEBRA SHALL NOT, UNDER ANY CIRCUMSTANCES WHATSOEVER, BE
LIABLETO THEBUYER OR ANY OTHER PARTY FOR LOST PROFITS,
DIMINUTION OF GOOD WILL, ORANY OTHER SPECIAL OR
CONSEQUENTIAL DAMAGES WHATSOEVER WITH RESPECT TO ANY
CLAIM HEREUNDER. IN ADDITION, ZEBRA’SLIABILITY FOR WARRANTY
CLAIMSSHALL NOT, IN ANY EVENT, EXCEED THE INVOICE PRICE OF THE
PRODUCT CLAIMED DEFECTIVE, NOR SHALL ZEBRA BE LIABLE FOR
DELAYSIN REPLACEMENT OR REPAIR OF PRODUCTS.

No salesperson, representative, or agent of Zebrais authorized to make any guarantee,
warranty, or representation in addition to the foregoing warranty.

NO WAIVER, ALTERATION, ADDITION, OR MODIFICATION OF THE
FOREGOING WARRANTY SHALL BE VALID UNLESS MADE IN WRITING
AND SIGNED BY AN EXECUTIVE OFFICER OF ZEBRA.

Software License Agreement

Software and documentation provided by Zebra are protected by the United States
copyright law and international treaty, and therefore you must treat them like a book,
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Warranty Information

with the exception that you may make copies of the software to protect yourself
against loss of the original.

Your right to use the software and documentation as described below is non-exclusive
and non-transferable. Zebra retains ownership of the software and documentation and
al other rights, title, and interest. The software and documentation may be used by any
number of people and may be freely moved from one computer to another aslong as
there is no possibility of their being used by more than one person on more than one
computer at the same time.

Machine readabl e files representing graphics or fonts that you have created
independently may be converted to ZPL format files using the software, and such files
may be used, copied onto diskettes or font cards, given away, or sold without paying
license feesto Zebra. Pictorial or graphic images and any machine readable files
representing them may be protected by United States copyright law and international
treaty provisions, which prohibit you from transcribing or scanning such images or
using, copying, or converting such files without permission of the copyright owner.
You may not use this software in violation of U.S. copyright law or international
treaty. By using this software, you agree to be bound by these terms.

Zebrawarrants the software diskettes to be free of defectsin material and
workmanship for a period of 60 days from the date of purchase. In the event of
notification within the warranty period of defectsin material and workmanship, Zebra
will replace the defective diskette or documentation. Zebra specifically disclaims all
other warranties, expressed or implied, including but not limited to implied warranties
of merchantability and fitnessfor aparticular purpose. IN NO EVENT WILL ZEBRA
BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER INCIDENTAL
OR CONSEQUENTIAL DAMAGES CAUSED BY ABUSE OR MISAPPLICATION
OF THE SOFTWARE OR BY ITSUSE IN VIOLATION OF THE U.S.
COPYRIGHT LAW OR INTERNATIONAL TREATY.

This product document refers to hardware and software products by their trade names.

ZebraNet® is atrademark of Zebra. The PrintServer |1 is aproduct of Zebra. All other
designations are trademarks or registered trademarks of their respective companies.
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Preface

The Preface discusses the topics and illustrates standards that are used throughout this
guide.
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Preface
Contacts

Contacts

You can contact Zebra, USA at any of the following:
Visit us at: http://www.zebra.com

Our Mailing Address:

Zebra

333 Corporate Woods Parkway

Vernon Hills, lllinois 60061.3109 U.S.A
Telephone +1 847.634.6700

Facsimile +1 847.913.8766

Zebra Technologies Europe Limited
ZebraHouse

The Valley Centre, Gordon Road

High Wycombe

Buckinghamshire HP13 6EQ, UK

Telephone +44 (0)1494 472872
Facsimile +44 (0) 1494 450103

Support

You can contact Zebra support with any questions or problems with your ZebraNet
PrintServer 11 (PSII):

Support email: http://support.zebra.com

Telephone: +1.847.913.2259

Feedback

Be sure to complete the feedback form located at the beginning of this guide.
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Preface
About this Document

About this Document

The ZebraNet PrintServer |1 User and Reference Guide consists of these chapters:

Title ‘ Content Description

Introduction This chapter provides a high-level overview of
the ZebraNet PrintServer Il (PSII), instalation
instructions, standard network configurations,
and how to work with PSII.

Installation This chapter provides information on how to
install PSII (external and internal) and the
ZebraNet Utilities.

Getting Sarted This chapter provides you with information on
how to work with the most frequently used
PSII features.

NetWare Print Configuration This chapter provides you with instructions on
how to configure Novell’s NetWare for printing
to PSII.

Printing Configurations This chapter provides information and
instructions on configuring your printer for
remote BSD-style LPD printing on the UNIX
operating system.

Using Printing Protocols This chapter provides information and steps to
set up your PSII to support Internet Printing
Protocol (IPP).

PrintServer |1 This appendix provides you with details on the
most commonly used PSII features.

ZebraLink This appendix provides you with detailed

For Zebralink-enabled information that allows you to use the

printers. enhanced functionality of your Zebral.ink-

enabled printer with the PSII.

ZebraNet Utilities This appendix provides you with details on
ZebraNet Utilities, the software suite of printer
administration tools that complements and
enhances both Zebral ink and the ZebraNet
family of connectivity products.
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About this Document

Hardware Troubleshooting

This section provides you with solutions to
known issues.

Frequently Asked Questions This section is a compiled group of frequently
asked questions (FAQs) about PSII.
Glossary This section isa glossary of termsthat are

specific to the PSII.
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Document Conventions

Document Conventions

G ) m o=

The following conventions are used throughout this document to convey certain
information:

About this Chapter Sections These sections list and describe each main section
of the chapter, including the initial page numbers of those sections. These sections
primarily serve as hyperlink components for the Adobe Acrobat . pdf version of this
guide.

Alternate Color (onlineonly) Cross-references contain hot linksto other sectionsin
thisguide. If you are viewing this guide onlinein . pdf format, you can click the
cross-reference (royal blue text) to jump directly to its location.

Command Line Examples All command line examples appear in Cour i er font.
For example, you would type the following to get to the Post-Install scriptsinthebi n
directory:

Zt ool s

Files and Directories All file names and directories appear in Cour i er font. For
example, the Zebr a<ver si on nunber >. t ar fileandthe/ r oot directory.

Warning, Caution, Important, Note, Tools, and Example Thesetopicsare
defined in the following example:

Warning ¢ Advisesyou that failure to take or avoid a specific action could result in
physical harm to you or the hardware.

Caution * Advisesyou that failure to take or avoid a specified action could result in
loss of data

Important ¢ Providesinformation that is essential to the completion of atask.

Note ¢ Indicates neutral or positive information that emphasizes or supplements
important points of the main text.
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W Tools ¢ Identifies the tools you need to accomplish a task.

= Example ¢ Providesan example, often ascenario, to better clarify asection of text.

lllustration Callout Instruction Illustration callout instructions are used when an
illustration contains either information about adialog box or step(s) to accomplishina

dialog box.

Thisillustration callout instruction identifies a section of the dialog box, and the other

callout shows stepsto follow:

Print Server Configuration - 10.3 4181 [ X

TCPAP | OuputPot | SNMP | Puotoooks | SNMPTrasps | In the Set
IP Address Besolution Permanent
® Set Permanent ) Use Metwork Protocol TexT-_box,

type in the
[00.00 X RARP print
X BOOTP s 's TP
X DHCP erver
address.

Subnet Mask: 255.255.255.0 Telnet/Hit:
Default Gateway: 0.0.0.0
WINS Server: 0.0.0.0

¥ Usze DHCP To Locate WINS Server

Password

Advanced

ilil (114 I Cancel

Help |

Xiv

When you are
finished, click OK.
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Related Documents

Related Documents

In addition to the ZebraNet PrintServer User and Reference Guide, the following
documents might be helpful references while using PSII:

@ Note * Most of these documents are available on our Web site.

e Wreless Card Socket Option (WCSO) Install and Users Guide

e The ZebralLink Solution Application White-paper

e ZBI Guide

e ZPL 11® Programming Guide \olume One: Command Reference for X.10

e ZPL 1I® Programming Guide Volume Two: The X.10 Environment
e EPL2 Programmer’s Manual
¢ Line Mode Programmer’s Manual
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CHAPTER 1

Introduction

This chapter provides ahigh-level overview of the PSII device, installation
instructions, standard network configurations, and how to work with PSII.

Contents
OVEIVIEBW .« ot v i et e e i e e s e nae s
Requirements ...........cciiiiiiinnnnnn.
Compatibility .. ..o viie i
Installation Types. . ..o voii i e
PSII Specifications. . .. ..o
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Overview

Overview

The PSllI isan optional factory- or field-installed device that connects the network and
your Zebra printer. If your printer is Zebralink-enabled, PSII provides you with a
browser user-interface for printer and PSII settings. If your printer also has ZebraNet

Utilities, you have even more functionality. For details, see ZebraNet Utilities on
page 3.

Q Important ¢ You can download the most recent version of ZebraNet Utilities from
= our Web site: www.zebra.com.

Illustration

Thisillustration shows the flow of all the components that work with PSII. The table

that follows this illustration identifies the components and how they enhance each
respective device:

e

Printer with PSII only e E D

.-'."-.

ZebraNet Utilities

Zebralink-enabled printer, with PSIT
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Overview

Components ‘ Description

Printer with PSll only  PSII givesyour printer these features:

0 e allows the remote monitoring and configuration
capability of the PSII using a browser.

e alowsyou to send unsolicited printer status mes-
sages via email-enabled devices.

ZebralLink-enabled A Zebral ink-enabled printer with PSII gives you all
printer with PSII the above-mentioned features (WebView and Alert),
o plus these features:

e ZBl ™ (Zebra BASIC Interpreter)—program-
ming language that works with ZPL Il to control
and interpret incoming text and data. This pro-
vides you with the ability to create stand-alone
applications using a printer and peripheral
devices, such as a scale or a scanner, without
needing a PC host. Internet-aware ZBI then trans-
mits data captured by these devices over your
LAN, WAN, or wireless network (adding the
Wireless Card Socket Option allows these fea-
tures to work over awireless network) via email
or TCP/ IP messaging.

NOTE ° PSII can be either field- or factory-installed
for additional features. For details, see Installation

Types on page 8.
ZebraNet Utilities ZebraNet® Utilitiesis a suite of software programs
e that work with PSII and enhance the features of

Zebral ink resident within ZPL-based printers. The
featuresinclude

o ZebraNet Alert lets you configure multiple event
aerts per device with different alerts going to dif-
ferent people. You are notified of alerts from
either visual or audio cues. You can also generate
advanced alert reports.
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Components ‘ Description

e ZebraNet Connect IP lets you, with Windows,
enable simple printer selection of an |P address-
able printer.

o ZebraNet View allows you to locate printers auto-
matically. ZebraNet View searches on parameters
such as | P address, subnet, printer model, printer
status, and many other user-defined characteris-
tics. It also offers powerful device management
capabilities.

o ZebraNet View Java Applet is a Java-based ver-
sion of the popular ZebraNet View. It givesyou
ZebraNet View capabilities in a non-Windows
environment.
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Requirements

This section lists the minimum requirementsfor PSII, which include software, browser
support, and hardware.

Software

These are the platforms supported by ZebraNet Utilities:

Windows™ NT®, 95, 98, 2000, Me
Novell® Netware®

The ZebraNet View Java Applet is supported by any Java-enabled browser:

UNIX®

Linux

Browser Support

Internet Explorer 4.0+
Netscape Navigator 4.08+

Any browser that isHTML 1.1
compliant

Hardware

These are the minimum hardware requirements:

M ES External Internal Internal
Field Upgrade | Factory

Xi Series (Xill and Xilll) ° ° °

R140 ° ° °
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Printers External |Internal Internal
Field Upgrade | Factory

PAX Series ° ° °

Z-Series® .

Stripe® Series J

1059 ° ° °

105 Se/160S °

2746 °

2746e ° °

2684 °

DA402, T402 °

2844 (EPL) . .

2844 (ZPL) . -

Ht-146 ° ox

2824 ° °

* future releases
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Compatibility
This section identifies the various components that are compatible with PSII.

ZebraNet Wireless Card Socket Option (WCSO) PSillisfully compatiblewith
WCSO.

Software HP JetAdmin, HP Web JetAdmin™, and HP OpenView™ all work with
PSII.

PrintServer Il User and Reference Guide 7
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Installation Types

PSII can be factory- or field-installed, as follows:

Factory Factory-installations are for new Zebra printers that are built with the
internal PSII option.

Field Field-installationsarefor Zebraprintersaready inthefield that do not havethe
PSII deviceinstalled. The PSII option can be installed on existing printers, as follows:

* External PSll—attaches to the printer parallel port

* Internal PSIl—for the appropriate Zebra printers, this option connects directly
to the main logic board

8 PrintServer Il User and Reference Guide
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PSII Specifications

Network Connection 10BASE-T UTP RJ5 connection. Auto senses | EEE- 802.3,
Ethernet |1, IEEE- 802.2, and |EEE 802.2/SNAP frame formats

Printer Connection Bi-directional, IEEE- 1284 Centronics parallel port

User Interface Adctivity indicator: bi-color display of operational status; test button:
diagnostic test and configuration printing

Size (external ZebraNet PrintServer Il) Length: 3.6" / 91.4 mm, Width: 2.5" /
63.5 mm, Height: 0.8"/ 20.3 mm

Weight (external ZebraNet PrintServerll) .50z/71g

Power Maximum 250mA at 5.25VDC; power provided by the printer (Centronics
pin 18, 5VDC at 200mA)

Environment Operating Temperature: 0° to 104°F (0° to 40°C); Storage
Temperature: —4° to 140°F (—20° to 60°C); Operating Humidity: 25 to 85% non-
condensing

Agency Approvals |EC950; Canadian DOC; FCC ClassB; C. I. S. P. R. 22-B;
EN50082-1: 1997; and AS/NZS3548

Warranty Threeyears
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CHAPTER 2

Installation

This chapter provides information on how to install PSII (external and internal) and

the ZebraNet Utilities.

PrintServer Il User and Reference Guide
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Installation
External PSII

External PSII

This section provides you with anillustration of the external PSII and the steps
required for itsinstallation.

Illustration
Thisillustration shows avisua of an external PSII. The calloutsidentify the important
components:
Parallel
/ Connector
Test
Button
Ethernet Status
Connector Indicator

@ Note * When necessary, refer back to this illustration during the installation steps.

1 Turn off the printer.
2 Onthe back of the printer, insert the PSII device into the parallel port.

12 PrintServer Il User and Reference Guide



Installation
External PSII

Thisillustration calls out the location of the parallel port and provides an enlarged
illustration of the paralléel port:

Parallel Port_|

3 Securethewirelocks.
4 Onthe back of the PSII, insert alive 10BASE-T cable into the Ethernet connector.
5 Turnon the printer.

A red status indicator blinks during the Power On Self Test (POST) and changesto
green when theinitialization is finished.

The Test button isasmall hole on the PSII device. To pressit, you need to insert
something small into the hole, like a paperclip.

6 Pressthe Test button located on the side of the PSII. This prints out a PSlI
configuration label.

Q Important « DPI and your firmware version:

- e For printers with firmware version 7.01 and higher, regardless of the
dpi, a2-inch (5 cm) label prints

e For printers with firmware version 7 and lower, see the table that fol-
lows.

PrintServer Il User and Reference Guide 13
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Installation
External PSII

This table shows you how to determine the minimum label width needed to print a
PSII configuration label for printers with firmware version 7 or lower:

600 1.25
300 2.50
200 3.69
150 5.0

Thisisan example of a PSII configuration label. The callouts identify the settings you
need to know. The table following the illustration callout provides a description of

Online
ZTC 140XiIII-2060dpi
None

PRINTER STATUS
CONNECTED TO
ERROR

ZebraNet™ PRINT SERVER CONFIGURATION

FIRMWARE IN THIS PRINTER IS COPYRIGHTED

each callout.
TCP/IP
ENABLED STATUS
10.3.4.102 ADDRESS 0
255.255.255.0 SUBNET MASK
10.3.4.1 DEFAULT GATEWAY
Enabled TIMEOUT CHECKING
NETWARE
ENABLED STATUS
Ethernet 802.3 FRAME FORMAT e
Unknown MODE
GENERAL
1928107 SERIAL NUMBER
0040681D6BAB HARDWARE ADDRESS e
6.30 (AG21A> FIRMWARE VERSION
ERROR
None GENERAL
Error reading from Telnet TCP/IP
None NETWARE
JET ADMIN
ENABLED STATUS
PORT CONFIGURATION
PORT NAME
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Callout ‘ Description

Thisshowsthel P addr ess, subnet mask, and
0 def aul t gat eway of the PSII device. If thel P

addressisseta 0. 0. 0. 0, you need theser i al

nunber (incallout 3) tosetthel P addr ess.

e This shows all the Novell settings.
Thisshowstheseri al nunber, har dwar e

addr ess (MAC addr ess),andf i r mvar e ver si on
of the PSII device.

PrintServer Il User and Reference Guide
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Internal PSII

Internal PSII

This section provides you with anillustration of an internal PSII and steps on how to
install it in the Zebra Xill, Xilll, 1058, and PAX-Series printers.

Q Important ¢ It isrecommended that this installation be performed by a qualified
= service technician. The service technician must follow these step-by-step
procedures.

Illustration

Thisillustration provides you with avisual of an internal PSII. The callouts identify
the important components:

Ribbon Cable

Connector _\

Test
Button

Status
Indicator

Ethernet
Connector

@ Note « When necessary, refer back to thisillustration during the installation.

W Tools * These are the tools you need for the installation:
e #1 Phillips screwdriver
e 3/32" Allen wrench

16 PrintServer Il User and Reference Guide



1 Turn off the printer and disconnect the AC power cord.

Installation
Internal PSII

Caution * Printer electronics are susceptible to static discharge. Wear an anti-static
wrist strap and attach it to the printer chassis when performing installations.

2 Ontheback of the printer, remove the two screws and the blank cover plate
positioned next to the main RS-232 and parallel interface connectors.

3 Toremove the side panel:

side panel.

For the Xill-, Xilll-Series, and 1059, remove the screws and remove the | eft

BEAD

DATA CABLE
CONNECTOR

RIBBON CABLE

FERRITE
BEAD

RIBBON CABLE

PrintServer Il User and Reference Guide
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Installation
Internal PSII

» For the PAX-Series, access the electronics by removing the mounting screws
from the printer’s PCB access panel and sliding the panel out.

Test

RIBBON CABLE

BUtON sy ¢ | ° . o 22 = °
A. 21 AN A0 <Al
- 3 i g
7N el P -7 FERRITE BEAD
& .
. FERRITE BEAD & \ RIBBON CABLE
Status £ S /
Indicator =4 4
L4

@ Note * The parallel port on the back of the printer is not operational when the
internal PSll isinstalled. The hardware of the PSII mounting bracket coversthe
parallel port.

4
5

9

Through the mounting slot, insert the ribbon cable and PSII.

Fold the cable and the ferrite bead back over the mounting bracket, and connect the
ribbon cable connector into the keyed Interface Data Cable Connector (J4) on the
main logic board. Secure the PSII interface board in place with the cover plate
screws that you removed early in this step sequence.

Confirm that all small cable connectors are tight.

Reinstall the PAX-Series PCB access panel or the left side-panel of the Xill and
Xilll-Series printers that you removed earlier in this step sequence.

Thiskit includes alabel printed with the Ethernet MAC hardware address for the
PSII. Remove the backing from the label and affix it to the back of the printer.

Reconnect the AC power cord and turn the printer on.

10 Consult your System Administrator before configuring the PSII for your network!

18

To establish the network connection, refer to the section applicable to your
network type.
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Installation
ZebraNet Utilities

ZebraNet Utilities

The ZebraNet Utilitiesis a software suite consisting of toolsto assist you with the
configuration of the PSII device, which gives you the flexibility to make changes to
settings, track errors, and more.

If you want to be certain you have the most recent version of the ZebraNet Utilities,
you can visit our Web site and download the most recent version.

For more details, see Overview on page 2 or ZebraNet Utilities on page 107.

(% Note ¢ Contact your System Administrator before installing this software.You must
have Administrator rights on your network to install most of these utilities.

The steps that follow reflect the steps and dialogs for atypical installation. If you plan
to conduct a custom installation, the dialogs you encounter or see will differ from
those in this step sequence.

1 Insert the CD-ROM into the drive.

Important ¢ Is AutoPlay enabled on your computer?
Q e Yes. Your computer automatically launches the installation.

¢ No. You need to navigate to the Sof t war e>Zebr aNet
Uil >set up. exe onthe CD-ROM and manually launch theinstal-
lation.

2 Click Next>.

Thisillustration shows the dialog box that lets you select the utilities that you want
to instal:
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ZebraNet Utilities

ii& ZebraNet Utilities - InstallShield Wizard |

Custom Setup

Select the program Features vou want installed.

Each of these

has drop- Click. o an icon in the list below to change how & feature is installed.

down menus . —EEabiire DEsGHEuE

to choose Zebrahiet View f browser based utiliey Ehat
from. Zebrahlet Alert locates and Facilitates configuring

Zebrahet Connect for TCPSIP
Febraket Connect For IPX[SPY
Zebra Met Yiew Java Applet 1.0

C:\Program FilestZebraiMet TCPIP Lkils!

ZMet II Prink Servers. Requires a
Java Yirtual Maching in Internet
Explorer or Metscape.,

This Feature requires Z39KE on
wour hard drive.

Tnistal | Efield

Help |

< Back

I Mext = I Cancel |

Q Important ¢ If you installed ZebraNet View Java Applet, you must complete the
= installation steps for ZebraNet View Java Applet on page 23.

3 Inthe ZebraNet Utilities dialog, select the features you want to install and click

Next>.

20
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ZebraNet Utilities

Thisillustration gives you the chance to reset your installation settings:
ji& ZebraNet Utilities - InstallShield Wizard

Ready to Modify the Program

The wizard is ready to begin installation.

Click. Install to begin the installation.

If wou want to review of change any of wour installation settings, click Back. Click Cancel ko
exit the wizard.

InistalShield

< Back Cancel |

4 Inthe ZebraNet Utilities dialog, you have the option to review and make any

changesto your installation settings. When you are satisfied with your installation
settings, click Install.
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ZebraNet Utilities

When the installation is complete, this dialog opens:

& ZebraNet Utilities - InstallShield Wizard

InstallShield Wizard Completed

The Installshield Wizard has successfully installed Zebraklet
Ltilities, Click Finish o exit the wizard.

< Bach

Zane] |

5 Click Finish.

Q Important « When the installation is complete, you need to restart your system for
= the changes to take place.
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ZebraNet View Java Applet

ZebraNet View Java Applet

If you selected ZebraNet View Java Applet when you were installing the ZebraNet
Utilities, you need to complete afew installation steps to work with this utility.

1 Fromthetask bar, select Programs>ZebraNet Utilities>ZebraNet View Java Applet
1.0.

This Security Warning dialog opens:
Security Warning |

Do pou want to install and run ' ava Plug-n 1.2.2" signed
on 6/25/1399 8:32 PM and distributed by:

Sun Microzsystems, I,

Publizher authentizity verified by VWenSign Commercial
Software Publizhers Ca,

Cautior: Sun Microsystems, Inc. asserts that this content iz
zafe. ou should anly installview this content if pou bust
Sun Microzyztems, Inc. to make that azzertion.

T

[ Always tust content from Sun Microspstems, [ne.

More Info |

2 Tobegintheinstallation, click Yes.
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ZebraNet View Java Applet

The Select Java Plugin Installation dialog opens:

' Select Java(TM) Plugin Installation ... |

Fleaze zelect the language. region and the
nearezt [ocation o download the installation.

Locale :

Reaqion: I 54 ;I

Awailable Locations:

avaSoft/Sun Micr

| Irstall I

3 Makethe selections that apply to your environment, and click Install.

The Software License Agreement opens.

Software License Agreement |

Pleaze read the following Licenze dogreement. Prezs the PAGE DOWHM key to zee
the rest of the agreement.

Sun Microzpztems, Ihe. -

Binary Code Licenze Agreement
RE&D THE TERMS OF THIS AGREEMEMT &MD &MY PROVIDED SUPPLEMEMTAL
LICEMSE TERMSICOLLECTIMELY "AGREEMENT") CAREFULLY EEFORE OPEMING
THE SOFTwaRE MEDIA PACKAGE. BY OPENING THE SOFTwWARE MEDIA
PACKAGE.
wOU AGREE TO THE TERMS OF THIS AGREEMEMT. IF YOU ARE ACCESSING THE
SOFTWARE ELECTROMICALLY, INDICATE ¥'0IUR ACCEPTAMCE OF THESE TERMS
B SELECTIMG THE "ACCERT" BUTTOM AT THE EMDOF THIS AGREEMEMT .
IF%0U DO MNOT AGREE TO ALL THESE TERMS, PROMPTLY RETURM THE
MUSED
SOFTwARE TOY0UR PLACE OF PURCHASE FOR & REFUMD OR, IF THE
SOFTWARE ;I

['o you accept all the terms of the preceding Licenze Aareement’? [f you choose Mo, Setup
will cloze. To inztall Java Runtime Environment, pou must accept thiz agreement.

¢ Back Tes Mo |
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ZebraNet View Java Applet

4 Read the License Agreement. To continue with the installation, click Yes.
5 Whentheinstalation is complete, click OK.

The Java page opens.

JEiIe Edit “iew Fawvorites Tools Help |

4} ZebraNet View - Microsoft Internet Explorer BIETE

jq-,-»,@

EreEh eIl Stop Fefresh

¥
j Address I@ CAProgram Files\ZebraMet, TCRIF Utils\view Java AppletZ ebraMetviewPlugin j

| Links

Locate ZebraNet Devices on Network:

IP Address | Serial # | Systerm Mame i&g%

Fearch Method: ILocaISubnet j »¥% Zebra

Address: |255.255.255.255
[ e |5

Begin Search | Help |

Readly... |_ Qpen in Mew YWindow Count: 0

;&tgzébra
ZebraNet View Web Configuration Utility

“When opening ZebralTetViewPlugin html, the Web Confiouration Applet will load in the top frame of the browser, and this file appears in the lower
frame.

To discovery Zebra network printers on your networls

1. Select search parameters:
o Local Subnet - broadeast to local subnet (255 255 255.255)
o Subnet Broadeast - Enter a subnet broadcast address (eg 10.10.10.255%
o Wulticast - If your networle router support Iulticast, just set the Tune to Live (Hopcount)
(note: WMulticast i not supported on MNetscape for all platforms)
2. Zelect "Begin Zearch” to locate printers
3. Links to Zebra Prnters will be displayed i the lst.
4. Zelect any printer from the st to comnect and confipure.

|»

|@ Applet started. I_I_L_E!} My Computer

N

6 You have these options:
» Towork with this utility, see ZebraNet View Java Applet on page 120.
» To closethe utility, click the X.
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CHAPTER 3

Getting Started

This chapter provides you with information and procedures for working with the most

frequently used PSiII features.
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Getting Started
Before you begin

Before you begin

PSII offers many features, but how you access and work with them is dependent on
your environment. Before you begin, you need to get information from the PSI|
configuration label.

Q Important « Make sure the printer is turned off.

1 Turnonthe printer and let it complete its power-up cycle.
2 Letthe PSIl completeits POST cycle.

The Test button isasmall hole on the PSII device. To pressit, you need to insert
something small into the hole, like a paperclip.

3 When thefirst few steps are done, press the Test button and hold it in for afew
seconds before you release it.
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A PSII configuration label prints. Your configuration label looks similar to this:

Getting Started
Before you begin

TCP/IP

ENABLED
16.3.4.1082
255.255.255.0
16.3.4.1
Enabled

NETWARE

ENABLED
Ethernet 802.3
Unknown

GENERAL

1928167
0040681DEBAB
6.30 (AB21AD

ERROR

None
Error reading from Telnet
None

JET ADMIN
ENABLED
PORT CONFIGURATION

Online
ZTC 148XillI-206dpi
None

STATUS

ADDRESS

SUBNET MASK
DEFAULT GATEWAY
TIMEOUT CHECKING

STATUS
FRAME FORMAT
MODE

SERIAL NUMBER
HARDWARE ADDRESS
FIRMWARE VERSION

GENERAL
TCP/IP
NETWARE

STATUS

PORT NAME
PRINTER STATUS
CONNECTED TO
ERROR

ZebraNet™ PRINT SERVER CONFIGURATION

FIRMWARE IN THIS PRINTER IS COPYRIGHTED

4 From the configuration label, you need to get these numbers:

For details on getting these numbers, see page 15.

5 Onthe configuration label that prints out for your PSII device, circle the above-

ADDRESS (IP address)
SUBNET MASK
DEFAULT GATEWAY
SERI AL NUMBER

HARDWARE ADDRESS (MAC address)

mentioned settings. You can now proceed to Assigning an |P Address on page 30.

PrintServer Il User

and Reference Guide
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Getting Started
Assigning an IP Address

Assigning an IP Address

Before you can begin working with PSII, you must get or assign an |P address for the
PSII device.

Q Important ¢ Throughout the step sequence in this chapter, there are some features
that require the default User ID and/or default password. If you are prompted, these

are the defaults:
e User ID: adni n

e Password: 1234
With Dynamic Host Configuration Protocol (DHCP)

If your network uses DHCP, the necessary configuration information must be set on
the PSII when the unit initially connects to the network and is turned on.

@ Note * Check with your Network Administrator to see whether your network uses
DHCP.

Without DHCP

If your network does not use adynamic | P addressing system (such as DHCP), you
need to set the IP address of the PSII device.

ZebraNet View

ZebraNet View is the Windows-based print server management and configuration
utility that came with your PSII.

Q Important ¢ The remaining sections are dependent on the successful installation of
ZebraNet Utilities, which you should have completed on page 19.
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Getting Started
Assigning an IP Address

1 From thetask bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.

Q Important « On theillustration that follows, take note of the H W addr ess
= columnand Seri al # column. Compare what you seein ZebraNet View with the
configuration label you printed out.

The ZebraNet View dialog opens:
Y.< ZebraNet View - Zebra Technologies Corporation
J Eile ErintServer Yiew Tools Help |
| & O =6
[mP»BL2 AR #| [T el %=
System Mame © | IPAddressl Hid Address | Serial # | Subnet Mask | Default Ga... | Product Type Froduct# | Datecode | Status
B Focus 1034102 004068106BAE 1928107 255.255.255.0 10341 ZebraMet PrintServer 46686 AOZ1A, Warning

ﬂTestlabm? 1034138  00406810935F 1938271 2552552550 10341 ZehraMNet PrintServer 46687 A2A2A, Good
P Hybrid 1034179 0040681093584 1938266 ZebraMet PrintServer  46R87 Good

AlZTA

FaorHelp. press F1 |Court: 3 |Protocol: TCRAP  [Wiew: ZGN i

2 Comparethe H W Addr ess or Seri al Nunber onthe PSII configuration
label with the H W Addr ess column on the screen to find the PSII you are
working with.

3 When you locate your PSiIl, select it.
4 From the menu bar, select PrintServer>Configuration.

Q Important ¢ If the PSII does not have an |P address, it shows in the main screen

with an IP of 0.0.0.0. If, after 2 minutes, you do not assign an |P Address, the PSII
defaultsto IP Address 192.168.254.254 or 198.102.102.254 (this depends on your
firmware version).

5 If your PSII does not have an I P address, complete these steps:
* Find your PSII and right-click it.
* Inthe small dialog that opens, enter an IP Address, click OK.
* ThePrint Server Configuration dialog opens.
» Set the Subnet Mask (required). Set the Default Gateway (optional).
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Assigning an IP Address

* Click OK.
The Print Server Configuration dialog opens:

Print Server Configuration - 10.3.4.179 |

TCR/AR ||:Iut|:uut Part | SNMP | Pratocals | SMMP Traps |

— IP Addrezs Rezolution
™ Set Permanent

[ 10,3 . 4 17

b ethods; [ Allow Timeout
¥ R&RP

¥ BEOOTP

¥ DHCP

[ Gleaning

| 255 . 255 . 285 . O

Default Gateway: I w. 3.4 1

e Senver I L N B
¥ Lse DHCP To Locate 'WINS Server

Subnet Mask:

Telnet/Http Pazsword | Advanced TCRAP |

(] I Cancel | Help |

6 Typeanew IP addressin the text-box illustrated above.
7 Enablethe Set Permanent radio button.

8 From the ZebraNet View menu bar, select PrintServer>Configuration.

9 Click the TCP/IP tab.

10 From the Print Server Configuration>TCP/IP tab, in the Subnet Mask text-box,
typeinyour subnet mask.

11 Confirm it is accurate, and click OK.

These steps are Optional.
1 From the ZebraNet View menu bar, select PrintServer>Configuration.
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Assigning an IP Address

Click the TCP/IP tab.

From the Print Server Configuration>TCP/IP tab, in the Default GateWay text-
box, type in your default gateway.

Confirm it isaccurate, and click OK.

In a non-Windows environment

These steps can be used with all printers. However, the liquid crystal display (LCD)
instructions are for Xilll units only.

Q Important ¢ Your PSII must have firmware 6.3 and higher and your Zebra printer
= must have firmware x.10 or higher with an LCD.

1

Turn on the printer and allow 2 minutes for all systemsto complete the self test. If
you do not have a network cable in the port, the PSII prints the configuration |abel
when it is ready.

On the printer front panel, press SETUP/EXIT.

On the printer front panel, press PREVIOUS twice until you reach the network
settings menu item.

You can edit any of the following network settings in order to communicate with
any PSII in your network environment.

Q Important * To change any of these settings, you need to use the default password:
= 1234.

« default gateway (default setting of 000.000.000.000)
* subnet mask (default setting 255.0.0.0)

* i p address (ifinitial default setting is0.0.0.0, after 2 minutesthis
defaults to 198.102.102.254 or 192.168.254.254—depends on firmware
version)

« ip protocol (gleaningonly, rarp bootp, dhcp, dhcp and bootp, al)

* i p resol ution (dynamic, permanent) The printer menu item |P
RESOLUTION must be set to PERMANENT if attempting to assign the IP
address from the front panel.
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Assigning an IP Address

Assigning an IP address via a Telnet session

If your environment is not Windows-based, this section is for you. However, this
method can be used in a Windows environment, too.

The methods used for assigning an | P address with a Telnet session are Satic Route
and Gleaning.

Q Important ¢ This appliesto any TCP/IP capable workstation/ host networked with
= the Zebra printer. Both the workstation/host and the PSII must be on the same

network segment.

Before you can Telnet to the PSII and configure it, you must first assign the PSIl a
temporary |1P address.

1 Turn on the printer and wait for 2 minutes to allow for the device self test.

During thistime, the PSII performs an address broadcast. If no addressis assigned
tothe unit (viaDHCP or Bootp), it uses adefault address. The default address used
varies with the version of firmware the PSII is using. Print the PSII configuration
label to confirm the address; for details see page 28.

2 Youcanusether out e add command to place the default IP address into the
workstation’s network routing table.

=) Example ¢ Inthe next step, **** isthe |P address on the PSII configuration label.

3 At the workstation/host command prompt (in Windows, go the DOS prompt),
type:
route add **** "|P address of the workstation" O

@ Note * The zero (0) placed at the end of the "route add" command is optional on

34

some systems.

4 Telnet to the PSII by typing:
"Tel net XXX. XXX. XXX. XXX"
The password is1234.
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Assigning an IP Address

5 When finished, you can alter the appropriate settings. When complete, do a reset
and alow the PSII self test to complete before proceeding with any
communications activity.

A method by which the PSII uses the | P address of the first ping packet that is sent to
its Hardware address.

1 Add anentry to the ARP table that assigns an | P address to an Ethernet (Hardware)
address.

The syntax for thiscommandis.arp -s "tenporary i paddress of
print server" "MAC Address (print server hardware
address)” arp -s <tenporary ip address> <MAC Addr ess>

=) Example ¢ Youwouldtype: arp -s 10. 3.50.59 00-40-68- 1D B9- 86

2 Power cyclethe printer.
3 Asthe printer reboots, begin a continuous ping to the address assigned previously.

@ Note « Most UNIX systems use a continuous ping.
To use a continuous ping from a Windows host, you must issue the
command: ping -t "i paddress".
4 When the PSII begins to respond, stop the ping activity.
In Windows, Ctrl + C halts the pinging.

5 Tenet to the PSII and assign the appropriate I P address, subnet mask, and gateway
if applicable.

6 Oncethisiscomplete, reset the PSII.
For details on resetting the PSII, see Reset on page 86.
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Setting Alerts

It isimportant to understand the relationship between the PSII and the printer when
you are establishing alerts. Here are the relationships you need to be aware of:

* Non-ZebraLink-enabled printers—can send aerts on only a specific set of
printer errorsthat are reported in the |EEE 1284 protocol.

» ZebralLink-enabled printers—ZebralLink allows for the printer to send aerts
not in the | EEE 1284 protocol.

ZebraNet View

In this section are step-by-steps instructions on how to set up an alert using ZebraNet
View. For information on setting up alerts using Zebral ink, see ZebraLink on page 38.

1 Inthe ZebraNet View dialog, from the menu bar select Print Server>Configuration.
2 Click the SNMP Traps tab.
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The Printer Traps check boxes are the alerts you can set from ZebraNet View.

Print Server Configuration - 10.3.4.149 |

TCRAP | Output Port | SNMP | Protocols  SNMP Traps |

Protocal: TCP/P il

— Trap Destination

TCPAP Addiess: d

| 255. 255.255.255 ~| _ Edt

Bemove

Hd:

Porte Ta Trap Printer Trapz

[w|Part 1 [w|Or-ling [Condition cleared]
[w?] CIFF-lire:

[w|Paper Out

[w]Printer Error

(] I Cancel | Help |

3 Enablethe alerts (printer traps) you want to set here and click OK.

4 To monitor the alerts you established, from the task bar select Start>ZebraNet
Utilities>ZebraNet Alert.
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Setting Alerts
The ZebraNet Alert dialog opens:

sebraiert Alert - [Active Log - Eventl log]
i@ File “iew Beport Windows Help - |E’|£|‘
D SHS BRK TS M L 2

Date & Time | Device | Description | Sewverity | Address  ~
o)1 214/2001 8:2916 P ZBR1937805 Device peformed acold start Warning 10.3.4.197
(@12/14/2001 82919 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:29:27 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:29:34 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:29:41 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:29:52 Pt ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
@ 12/14/2001 82954 P ZBR1335920 Port 1 - Off Line Infarmatio...  10.3.4.149
@ 12/14/2001 8:29:56 P ZBR1335920 Port1-Cn Line Infarmatio...  10.3.4.149
(@)12/14/2001 8:29:56 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 &:30:08 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
@ 12/14/2001 83010 P ZBR1335920 Port 1 - Off Line Infarmatio...  10.3.4.149
@ 12/14/2001 830112 P ZBR1335920 Port1-Cn Line Infarmatio...  10.3.4.149
(@12/14/2001 830112 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 :30:30 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 :30:39 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 &:30:46 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 :30:53 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@ 12/14/2001 83059 P ZBR1937805 Device peformed acold start Warning 10.3.4.197
(@12/14/2001 &3:04 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
@ 12/14/2001 B31:09 P ZBR1335920 Port 1 - Off Line Infarmatio...  10.3.4.149
@ 12/14/2001 #3111 P ZBR1335920 Port1-Cn Line Infarmatio...  10.3.4.149
(@12/14/2001 311 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 &3:20 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 831:31 PM ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 &340 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:31:52 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 8:31:58 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 &:32:07 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
(@12/14/2001 83217 P ZBR1335920 Port 1 - Cut of Paper Warning 10.3.4.149
12/14/2001 8:32:30 P ZBR1935920 Port 1 - Cut of Paper Warning 10.3.41 4iILI

| | »

In thisdialog you can view the log of errors and monitor the activity of your
printer(s).

ZebralLink

In this section are step-by-step instructions on how to set up an alert using Zebral.ink.
For information on setting up alerts using ZebraNet View, see ZebraNet View on page
44,

Q Important ¢ If you do not have a Zebral ink-enabled printer, these stepswill not
| work.

1 From the Printer Home Page, click Alert Setup.
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The Alert Messaging System dialog opens.

2 ZTC 105SL-300dpi - Alert Me 1ol x|
J File Edit Wiew Favorites Tools Help ﬁ
| ¥Back v = ~ @ [ @ | QSearch EFavorites PHistory | »
| Address (&1 http://10.3.4. 149/printer funs ~|||Links ”

rY

Zebra Technologies
ZTC 105SL.-300dpi

Home

Alert Messaging System

| Condition D)esﬁnaﬁnn|SET|CLR|Address mh&:ﬁuns

(L) PAPER OUT [ TP [ v [ ¥ [1034.118] 0[Delete

(4) PAPER.OUT [F)SNMP | ¥ [ ¥ [10.3.4.118] 0| Delete

(B)RIBRON OUT|[F)sNMP | ¥ [ ¥ [10.34.118] 0[Delete

(E) HEAD OFEN |[F)SMMP | ¥ | ¥ [10.3.4.118] 0| Delete
Add Alert Meszage

Home: HTTE/MW W W ZEBEA COM
Support: HTTPASUFPORT ZEBR A COM

|@ ’7 ’7 ’@ Internet

To add an alert, you need the default user 1D and password.

2 Toaddanalert, click Add Alert Message.
Select accordingly.

4 You can use ZebraNet Alert to monitor aerts set through a Zebral ink-enabled
printer.

N

w

From this Web page you can add a ert messages to notify you when a printer is out of
paper, needs a ribbon, and so on.

Establishing Email Alert Messaging

ZebraNet Alert supports email notification of printer errors sent directly to any valid
email address. You can have multiple email addresses set up for routing different error
messages, or split notifications between email and other network management tools.
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1 From the browser view, in the Address text-box type in the printer’s | P address.

The Printer Home Page opens.

JEiIe Edit “iew Favorites Tools Help |

<~ = @ > Add . "
- - rass hitp://10.3.4.102/printerfindescht =
j Back FEaEryare Stop Refresh — I@ pif fprinter/index J
| Links

E& Zebra

Zebra Technologies
ZTC 140XiII1-200d pi

Status: READY

Printer Home Page

View Printer Configuration
View and Modify Printer Settings
Directory Listing
Alert Setup
Printer Controls
Print Server Settings

Home: HTTEWWACW L ZERRA COM
Support: HTTEASUPPORT ZEBRA COM

|@ |_|_|ﬂ Internet
2 Fromthe Printer Home Page, click Alert Setup.

The Alert Setup page shows alist of message notifications and their respective
destinations (if no notifications are listed).

3 To set up email notification, go to the Alert Setup page and click Add Alert
Message.

N
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The Add Alert Message page opens:
AJ ZTC 140Xil11-200dpi - Add Alert Me._. EIEY

J File Edit ¥iew Favorites Tools Help |
¥
N ) jAgdress

Back eIl Stop

Zebra Technologies
ZTC 140XiII-200dpi

Home

Add Alert Message

Condition: IPAPER ouT LI

Destination: | SERIAL i
SET: [vEs =]
CLR: I YES = l

Address: I

Port: I

Add Alert Message |

Password I

Alert Betup

Home: HTTP /WA ZEBRA COL
Support: HTTE/SUTPPORT ZEBRA COM

|@ |_|_|ﬂ Internet

A=

Q Important ¢ The printer accepts only the last configuration made.

4 Specify the condition to send over email, such asHEAD ELEMENT BAD or
PAPER OUT.

5 Enter avalid email address for the messages to be sent to.

=) Example * adm n@our conpany. net (The Port field can be ignored for

emalil setup.)
' Warning * A password isrequired. If you forget to enter the password, the alerts
o you just set are deleted.

6 Click Add Alert Message.
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7 You can continue to add more settings or, if finished, save the current settings.

8 From the Printer Home Page, select PrintServer Settings>Network
Communications Setup.

9 Click SMTP Email Alerts.

@ Note « The SMTP Server address might be referred to as Mail Server address.

42

10 Specify your SMTP server address.

When these steps are done, you can begin recelving email notification messages.

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet Alert.
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The Active Log dialog opens, displaying alist of all the logged alerts:

[] ZesraNet Alerf - [Active Log - Eventl log]

”i File Wiew Report MWindows Help - |E|i|

D zRe BRx et #n e

Date & Time | Device | Description | Severity | Address =

@1 21452000 82916 P ZBR19373805 Device perfarmed a cold stant “Warning 10.3.4.197
(@) 12/14/2001 8:22:19 P ZER1935920 Faort 1 - Out of Paper “Warning 10.3.4.145
@) 12/14/2001 8:29:27 P ZBR1535920 Port1 - Out of Paper YWarning 10.3.4.1489
(@) 12/14/2001 8:29:34 P ZBR1535920 Port1 - Out of Paper “Warning 10.3.4.148
(0)12/14/2001 8:22:41 P ZBR1935320 Port1 - Out of Paper “Warning 10.3.4.148
(@) 12/14/2001 8:29.52 PM ZBR1935320 Fart1 - Out of Paper “Warning 10.3.4.145
@ 12/14/2001 8:2954 P ZBR1935920 Fart1-0ff Line Informatio... 10.3.4.143
@ 12/14/2001 8:29.56 P ZBR1535920 Fort1-0n Line Informatio...  10.3.4.149
(@) 12/14/2001 8:29:56 P ZBR1535920 Port1 - Out of Paper “Warning 10.3.4.148
(0)12/14/2001 8:30:08 P ZBR1935320 Port1 - Out of Paper “Warning 10.3.4.148
@ 12714/2001 23010 P ZER1935320 Fart1-0ff Line Informatio... 10.3.4.143
@ 127142001 83012 P ZER1935320 Faort1-0nLine Informatio... 10.3.4.143
@ 12014/2001 83012 P ZBR1935920 Fort1 - Out of Paper Warning 10.3.4.148
@) 12/14/2001 8:30:30 P ZBR1535920 Port1 - Out of Paper YWarning 10.3.4.1489
(@) 12/14/2001 8:30:39 P ZBR1535920 Port1 - Out of Paper “Warning 10.3.4.148
() 12/14/2001 8:30:46 PM ZBR1935320 Port1 - Out of Paper “Warning 10.3.4.148
(@ 12/14/2001 83053 P ZBR1935320 Fart1 - Out of Paper “Warning 10.3.4.145
@1 2402001 8:3059 P ZBRI1937E05 Device perfarmed a cold start ‘Warning 1034197
@) 12/14/2001 8:31:04 P ZER1535920 Port1 - Out of Paper YWarning 10.3.4.1489
@ 12/14/2001 8:31:09 P ZER1535920 Port1-0ff Line Informatio...  10.3.4.1489
@ 127142001 83111 PM ZBR1935320 Port1-0n Line Informatio...  10.3.4.143
(@ 12/14/2001 83111 PM ZBR1935320 Fart1 - Out of Paper “Warning 10.3.4.145
(@) 12/14/2001 8:31:20 P ZER1935320 Faort 1 - Out of Paper “Warning 10.3.4.145
@) 12/14/2001 83131 P ZBR1535920 Port1 - Out of Paper YWarning 10.3.4.1489
(@) 12/14/2001 83140 P ZER1535920 Port1 - Out of Paper “Warning 10.3.4.148
(0)12714/2001 823152 P ZBR1935320 Port1 - Out of Paper “Warning 10.3.4.148
(@ 12/14/2001 83158 P ZBR1935920 Fart1 - Out of Paper “Warning 10.3.4.145
() 12/14/2001 8:32:07 PM ZBR1935920 Faort 1 - Out of Paper “Warning 10.3.4.145
@) 12/14/2001 83217 P ZBR1535920 Port1 - Out of Paper YWarning 10.3.4.1489
@12;1 4/2001 §:32:30 P ZBR1935920 Port1 - Out of Paper “Warning 10341458 =
< | | |
& Active Log-...|

ForHelp, press F1 | Log Events: 1147 |Cache Events: 1147 |WiewEBve

2 Fromthisdialog, you can track the printer(s) activity and status.
3 From the menu bar, you can explore all the other features, such as Reports.
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Checking PSII Configuration Settings

This section provides steps on how to check PSII's configuration settings using
ZebraNet View and a browser.

ZebraNet View

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.
The ZebraNet View dialog opens:

"z ZebraNet View - Zebra Technologies Corporation
JEME: Print Server View Tools Help ‘

| &GN B

ERY Y

System Name © | \PAddress| Hi Address | Serial # | SubnetMaskl Default Ga... | Product Type | Prudud#l Datecude| Status |
HRFocus 10.3.4102  00406870D6BAB 1928107 255.256.255.0 10341 ZebraMet PrintServer 46686 ADZTA Wyarning

B Testlab-107 1034136 00406G1D935F 1938271 255.256.266.0 10.341 ZebraMet PrintSerser 46687 AZ4ZA Good
LfZPL Hybrid - 10.3.4.179 Q354 50 10.3.4.1 Zebralet PrintSerser  4bbE7 Good

Faor Help, press F1 |Count: 3 [Protocol: TCPAP  [Wiew: ZGN 4

2 From the menu bar, select Print Server>Configuration.
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The Print Server Configuration dialog opens:

Print Server Configuration - 10.3.4.179 |

TCR/AR ||:Iut|:uut Part | SNMP | Pratocals | SMMP Traps |

— IP Addrezs Resalution

™ Set Permanent

[ 10,3 . 4 17

b ethods: [ Allow Timeout
v | BARP

v EOOTP

¥ DHCP

[ Gleaning

| 255 . 255 . 286 . O
[ 103 4 1

WS Senver: I w3 .1 8
¥ Use DHCF To Locate WINS Server

Subnet Mask:

Default Gateway:

Telnet/Http Pazswond | Advanced TCRAP |

(] I Cancel | Help |

3 Thisdiaog offers multiple tabs to choose from. Each tab contains various
configuration settings that you can change.

For details on the configurations, see page 108.

Browser

This section provides steps on how to check PSII’'s configuration settings using its
Web pages.

1 Open aWeb browser.
2 Inthe Addresstext-box, type your printer’s | P address, then press Enter.

PrintServer Il User and Reference Guide



Getting Started

Checking PSII Configuration Settings

Your browser page looks similar to this:

JEiIe Edit “iew Favorites Tools Help

=
Back

@ JAereSS I@ http:,-",-"1D.3.4.1DZ,-"printer,-"index.htj

Stop Fefresh

| Links

E& Zebra

Zebra Technologies
ZTC 140XiII1-200d pi

Status: READY

Printer Home Page

View Printer Configuration
View and Modify Printer Settings
Directory Listing
Alert Setup
Printer Controls

Print Server Settings

Home: HTTEWWACW L ZERRA COM
Support: HTTEASUPPORT ZEBRA COM

N

€]

|_|_|ﬂ Internet

3 From the Printer Home Page, click Print Server Settings.

The default User ID and password are required.

Q Important ¢ Theillustration of the Printer Server Settings page is based on a ZPL
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printer. If you have an EPL printer, the menu options on the Print Server page are
dlightly different.
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The Print Server Configuration Page opens:

R http:#10.3.4. 102/server] - Microsoft Internet ... M=l E3
JEiIe Edit Miew Fawvorites Tools  Help

-,

- L

Emyarc

D

stop

Fefresh

=
Back

i

|,&gdress

Focus - ZebraNet PrintServer

Status and Configuration
Printer
Print Server

Print Joh=

JobLog
Cancel Joh

Print Server Status
View Confisuration Sheet
View Port Status

Support
Contact

FaQ
Updates

Reset
Eeset Printer
Eeaet Print Setver

Restore

Factory Default Printer Settings
Factory Print Server Settings

|@ Done | | |@ Internet

N

1 From the Print Server page, click Print Server.
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The Print Server Configuration page opens:
A http:1110.3.4.102/serverimenu_ htm - Micr... [I[=]1E3

JEiIe Edit Aiew Faworites Tools Help |

>
- > = @ Address
Back A Stop

Focus - ZebralNet PrintServer

Print Server Configuration

Enabled Protocols
Hetware

TCPAR Confisuration
TCPAP Logical Printing Ports
Syratem (SHLE)

[P &letts (Traps)
[P Alerts (Traps

ELITE Email Aletts
Web & dimin
POP3 E-Iail Printing

| Home | Print Server Config |

|-
|@ Done |_|_|* Internet i

2 For details on the configuration choices, see To check configuration settings,
complete these steps: on page 44.
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Setting up a ZebraNet Connect IP

ZebraNet Connect |P allows you to send jobs to PrintServers that use Dynamic I[P
addresses (DHCP). It aso notifies you of printer errors, such as paper out or head
open. When print jobs are printed through ZebraNet Connect IP, they are sent directly
to PSII and are not routed through a network server, resulting in areduction of network
traffic.

Note « The DHCP feature of ZebraNet Connect | P can rediscover aPSIl on thelocal
subnet, even when its I P address might be changing (e.g., when using DHCP for IP
address resolution). The PSII isrelocated by its port name as configured through
ZebraNet View (the default name is Serial Number-Port Number). Thisfeature is
enabled on the local subnet only. A non-local PSII deviceis not rediscovered if the
| P address changes.

If you have printing problems while using the ZebraNet Connect I P printing port, you
may check the status of the port or change its settings through the printer Properties
dialog.

e For Windows 95/98, select Port Settings under the Details tab.

e For Windows NT 4.0 or Windows 2000, select Configure Port under the Ports tab.

Windows NT 4.0/Windows 2000

%

If you are using the Windows NT 4.0 or Windows 2000 operating system, use the
following procedure to set up a printer port for the PSII.

1 From thetask bar, select Start>Settings>Printers.

Select the Windows printer to use when printing with the PSII.

From the menu bar, select File>Properties.

To add a ZebraNet Connect I P port, in the Ports tab select Add Port.

From the list of Available Printer Ports, select ZebraNet Connect Monitor as the
type of port to add, and click New Port.

A h~hOWOD

Note « If ZebraNet Connect IP monitor is not listed, verify that the ZebraNet
Connect | P software has been properly installed. To do this, you need to reinstall the
software and choose Modify.
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You enter into the Add ZebraNet Connect Port screen, wherethereisalist of all
PSII devices available on the loca subnet.

» The TCP/IP monitor searches only the local subnet.
* The IPX/SPX monitor retrieves al devices found in the NetWare bindery.

6 If the port you want to add islisted in the Ports Available on Local Subnet window,
select the port name. If the port you want to use is not listed, you can:

» Select Cancel and repeat step 5 to rediscover the print servers.

* |n ZebraNet Connect for IPX/SPX, click Search and enter the PrintServer’s
Network Number and Hardware Address.

In ZebraNet Connect, click the Locate Non-local Device button and enter the static
TCP/IP Address used for the PSII.

@ Note ¢ The ZebraNet Connect for TCP/IP DHCP discovery feature relocates a PSl|
device on the local subnet by its port name, even if the | P address changes. This
feature is enabled on the local subnet only. A non-local PSII deviceis not
rediscovered if the IP address changes.

7 Click Add.
8 Toclosethe Printer Portsdialog, click Cancel.

9 To savethe configuration, click OK.
Now you can use ZebraNet Connect. Whenever you print to the Windows printer

configured with ZebraNet Connect, your print job will go directly to the ZebraNet PSI|
port.

Windows 95/98/Me

1 From thetask bar, select Start>Settings>Printers.
2 Select the Windows printer that you want to print with ZebraNet Connect IP.

@ Note  Under Windows 95, you have to set up the printer for alocal port first, then
open Properties from the File menu and continue with the configurations.

3 From thefile menu, select File>Properties.
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4 To add aZebraNet Connect IP port, in the Details tab select Add Port.

5 Fromthe Add Port dialog, select Other, then select the ZebraNet Connect Monitor
as the type of port to add.

6 Click OK.

{% Note « If ZebraNet Connect IP isnot listed, verify that the software has been
properly installed.

The Add ZebraNet Connect Port screen opens. Thereisalist of all PSII devices
discovered on the network.

* The TCP/IP monitor searches only the local subnet.

* The IPX/SPX monitor retrieves al devices found in the NetWare bindery.

7 If the port you want to add islisted in the Ports Available on Local Subnet window,
select the port name. If the port you want to use is not listed, you can:

» Select Cancel and repeat step 5 to rediscover the PSII devices.

* |nZebraNet Connect IP for IPX/SPX, click Search and enter the PSII's
network number and hardware address.

* In ZebraNet Connect |P, click the Locate Non-local Device button and enter
the static TCP/IP address used for the PSII.

8 Click Add.
9 To savethe configuration, click OK.

Now you can use ZebraNet Connect |P. Whenever you print to the Windows printer
configured with ZebraNet Connect IP, your print job will go directly to the PSII port.

IPX (NetWare)

ZebraNet Connect for IPX/SPX isa utility that allows simple, direct, |PX/SPX
printing from your computer to a printer attached to aZebraNet PSII. Print jobs printed
through the ZebraNet Connect utility are sent directly to the PSII and do not require a
NetWare server, resulting in a reduction of network traffic.

If you have printing problems while using the PSII Connect printing port, you can
check the status of the port or change its settings under the printer Properties window.

e For Windows 95/98, select Port Settings under the Details tab.
e For Windows NT 4.0 or Windows 2000, select Configure Port under the Ports tab.
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Notify on Printer Error—This feature checks the printer status prior to printing
thejob. If aprinter error is detected (e.g., printer off-line), the error description is
given.

Notify When Printed—This feature provides an alert when your job is active on
the printer. Thisisuseful if the printer is unusually busy.

Description—An optional field inwhich you can list any useful information about
the printer port, such as location.
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Enabling Protocols

You can enable protocols with WebView or ZebraNet View. This section providesyou
with directions for accessing and enabling protocols using both WebView and
ZebraNet View.

WebView

This section contains directions for accessing protocols using WebView. The browser
illustrations were captured from a Zebral ink-enabled printer.

1 Open aWeb browser.
2 Inthe Addresstext-box, type your printer’s | P address, then press Enter.

Your browser page looks similar to this:

JEiIe Edit “iew Favorites Tools Help |

<~ = @ > Add . "
- - rass hitp://10.3.4.102/printerfindescht =
j Back FEaEryare Stop Refresh — I@ pif fprinter/index J
| Links

Zebra Technologies
ZTC 140XiII1-200d pi

Status: READY

Printer Home Page

View Printer Configuration
View and Modify Printer Settings
Directory Listing
Alert Setup
Printer Controls
Print Server Settings

Home: HTTEWWACW L ZERRA COM
Support: HTTEASUPPORT ZEBRA COM

|@ |_|_|i Internet

N
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3 From the Printer Home Page, click Print Server Settings.

The default User ID and password are required.
4 Fromthe Print Server page, click Print Server.

The Print Server Configuration page opens:
A http:1110.8.4.102}serverimenu htm - Micr_.. [M[=]E3

JEiIe Edit “iew Faworites Tools Help |
B = 5

-

Back [Enyars Stop

»»

‘AgdreSS

Focus - ZebralNet PrintServer

Print Server Configuration

Enabled Frotocols
Wetware

TCRIP Confiquration
TCEAF Logical Printing Ports
System (BHNLIF)

[PEC Alerts (Traps)

IP &lerts (Traps
ZITE Email Alerta
Weh A dmin

FOFP3 E-Mail Printing

| Home | Pritit Server Confiz |

i
|@ Done ’_’_lﬂ Internat i

5 Fromthe Print Server Configuration page, click Enabled Protocols.
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The Protocol Configuration page opens.

2 http:1/10 3.4 102/server/PROTOCOL htm __ M= E3
JEiIe Edit “iew Favaorites Tools Help |
Az - = @ »‘Agdress Links
Back EaryErd Stop
- |
] 1
Focus - ZebraNet PrintServer
Protocol Configuration
Protocols: ¥ Metware
¥ HP Jet dmin
Submit Changes
| Hote | Print Server Config |
Printer Config
<]
|@ Done ’_’_|ﬂ Internet s

6 Select the protocols you want to enable, then click Submit Changes.

You get a confirmation to reset the unit for changes to take place.

ZebraNet View

This section contains directions for accessing protocols using ZebraNet View.

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.
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The ZebraNet View dialog opens:

Y.< ZebraNet View - Zebra Technologies Corporation

J Eile ErintServer Yiew Tools Help |

| & O =6

DPELA N AR Tl

System Mame © |IPAddress| Hid Address |Serial# | Subnet Mask | Default Ga... | Product Type Froduct# | Datecode | Status

B Focus 1034102 004068106BAE 1928107 255.255.255.0 10341 ZebraMet PrintServer 46686 AOZ1A, Warning
ZehraNet PrintServer 46687 A2AZA, Good

Bl Testlah-107 10.3.4.138  0040681D935F 1938271
{ZPL Hyhrid - 10.3.4179 004068109354, ]

er 46687 AN21A Good

ZebraMet Print

FaorHelp. press F1 |Court: 3 |Protocol: TCRAP  [Wiew: ZGN i

2 From the menu bar, select Print Server>Configuration.
3 Click the Protocols tab.

The Protocols tab opens:

Print Server Configuration- 1034179 [

TCPAP | Output Port | SHMP  Pratocals | SNMP Traps |

Praotocolz Enabled

WITCFAF
[w|MH et are
[wW]HF Jetddmin

Ok I Cancel | Help |

4 Select the protocols you want to enable, then click OK.

A confirmation message opens.

5 To accept changes, click OK.
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Defaulting the PSII

This section provides you with instructions for defaulting the PSII to factory settings
using WebView, ZebraNet View, and the Test button.

WebView

1 From the ZebraNet PrintServer view, click Factory Print Server Settings.

The Restore to Factory Defaults page opens.
N} http:#10.3.4.102/serverRESTOR ... [M[=] 3

JEiIe Edit iew Fawvorites Tools Help |

b
« 0 @ Address
Back R =i Stop

Focus - ZebralNet
PrintServer

Restore To Factory Defaults

Restore: [~ ]l Settings
[ TCPAP
M HetWare

Submit Changes

| Home | Print Server Config |
Printer Config

|@ Daone |_|_|Q Internet

N E
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2 Enablethe check box of the settings you want to reset, and click Submit
Changes.

Q Important « With the reset command on its way to the PSII, the HTTP connection
is unavailable while the PSII re-initializes. You need to wait afew seconds before

trying to reestablish a connection.

ZebraNet View

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.

The ZebraNet View dialog opens:
Y.< ZebraNet View - Zebra Technologies Corporation
J Eile ErintServer Yiew Tools Help |
| O ~Tas
DPELA N AR Tl

System Mame © |IPAddress| Hid Address |Serial# | Subnet Mask | Default Ga... | Product Type Froduct# | Datecode | Status

0040681D6BAE 1928107 255.255.256.0 10.3.41 ZehraNet PrintServer 46636 ADZTA Warning

B Focus 10.3.4.102
1034138  0040681D935F 14 1 2552562550 10341 ZehraMet PrintServer 46637 A2A2A Good
ZPL Hybrid 1034179 004068109354 [ 2660 10341 Zebralet PrintServer 46637 AN21A Good

FaorHelp. press F1 |Court: 3 |Protocol: TCRAP  [Wiew: ZGN i

2 From the menu bar, select Print Server>Reset.
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The Reset Print Server dialog opens:

Reset Print Server [ x |
Rezet |

Restore Factory Default Settings

Festare | [ ]0utput Ports

[CITCRAR
M etw ane

Help |

3 Select the settings you want to reset, then click Restore.

Test Button

1 Theprinter isturned off.

The Test button isasmall hole on the PSII device. To press the Test button, you
need to insert something small into the hole, like a paperclip.

2 With the printer turned off, press and hold the Test button on the PSII device and
turn on the printer.

3 Thestatusindicator tells you when PSII has been reset to factory defaults, as
follows:

* If an active network cable is connected to the PSII, the status indicator turns
solid green. When this happens, you can release the Test button.

» If thereisnot an active network cable connected to the PSII, the status
indicator flashes green. When this happens, you can release the Test button.

» For more details on status indicators, see Satus Indicator on page 124.
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CHAPTER 4

NetWare Print Configuration

This chapter provides you with instructions for configuring Novell’s NetWare for
printing to PSII.

Contents
Printing in PServerMode ................ 62
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Printing in PServer Mode

You must have Zebra's snap-in for Novell installed to compl ete these steps.

Q Important  You must have PSII installed before you proceed with these steps.

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.
2 Create aZebraNet object by completing the following steps:

From Novell’s NetWare Administrator, select the container in which you want
the object created.

=) Example ¢ To create an object that is subordinate to sales, choose SALES.

62

From the menu bar, select Object>Create.

If the Create option isgray, you do not have sufficient rights, or you selected a
leaf object.

Find Zebra Print Server, select it, and click OK.

If the class of the object you want to create is not listed, you cannot createit in
the container you selected.

Define filter and sort devices for displaying alist of PSII devices to choose
from, and click OK.

Typein aname for the new PSII object, and click Create.

Wait for the print server to reset.

(optional) To rename one of the PSII devices, select the one you want to
rename, and click Create.

3 Inthe Directory Tree, find your object, and double-click.
4 Select Assignments>Assign>New.

5 Next to the Context text-box, click the Directory Treeicon, then double-click the
browse arrow.

6 Find the Contexts container you want, and double-click.

It auto-fills into the Context text-box.

PrintServer Il User and Reference Guide



NetWare Print Configuration
Printing in PServer Mode

7 Enter the printer name you want, and click Create.
8 Next to the Print Queues section, click New.

9 Next to the Context text-box, click the Directory Tree, and double-click the
Browse arrow.

10 Select the Context you want.
It auto-fills the text-box.
11 In the Print Queue Name text-box, type in the name you want.
12 Next to the Print Queue Volume text-box, click the Directory Treeicon.
13 Double-click the Volume you want, and click Create.
Your Print Queue Name is listed with the name of your Context as the extension.
14 Click OK, and then click OK again.
Wait for the print server to reset.
15 To refresh your Directory Tree, double-click on your context twice.

You now see the Object, Printer Name, and Print Queue that you created.

1. On Add Printer double-click, and click Next.
2 Select Network Printer, and click Next.
3 Click Browse and click on the context.

You can see the queue and printer that you created.
4 Select the queue, and click OK.
The Network path (queue name) auto-fills.

Click Next.

Select Generic for Manufacturer of printer, and click Next.
Select Keep Existing Driver, and click Next.

Enter the printer name you want and click Next.

Select No for printing a Test Page, and click Finish.

10 From the Printersdialog, double-click on your new printer and set it as the default
printer.

11 Open atext editor, create ZPL (Zebra Programming Language) file, and print.

©W 00 N O O,
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CHAPTER 5

Printing Configurations

This chapter provides information and instructions on configuring your printer.

Content
BSD (Berkeley Software Distribution)-Style Print
QUELE ...ttt e e 66
System V Queue Installation.............. 68
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BSD (Berkeley Software Distribution)-
Style Print Queue

BSD isaversion of the UNIX OS that distributes software that includes TCP/IP.

Configuring the Print Queue

66

For remote BSD-style LPD printing, add the PSII as aremote printer in the /etc/
printcap database to each host printing to the PSII. You can add printcap options as
needed. If you are unfamiliar with these options, consult the printcap documentation.

Important « You must beloggedinasr oot .

The entry looks similar to this:

| ocal _print_queue_nane|[printer_nodel and _nmanufacturer]
o\

: 1 p=: mx#0: r m=Zebr aNet _nane: \
:rp=renote_print_queue_nane:\

:sd=path_to_spool directory:If=just log file_nane

| ocal _print_queue_name—This definesthe name of the printcap entry. It is
used by the LPR/LPD utilities to specify which printcap entry is being referenced.
Additional printcap entries can be added as needed for different queue types. Each
entry must have aunique local_print_queue _name and a different spool directory to
work properly. When you are ready to print, use the local_print_queue _name that
matches the data type of the file to be printed.

Zebr aNet _name—Thisisthe name (alias) of the ZebraNet PSII. This must be the
same name as entered inthe/ et ¢/ hostsfile or your NIS or DNS system. An IP
address may also be used here.

renot e_print_queue_name—Thisentry determines the ZebraNet port where

the print job will be printed and optionally specifies ASCII printing that must end for
LF1.
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pat h_t o_spool _direct or y—Thisisthe path to adirectory wherethe print jobs
will be spooled for this queue. You must create a unique spool directory for each

printcap entry.

| og_fil e_name—Thisisthe path to afile where error information from the LPD
will be logged.

=) Example ¢ Your printcap entries might look similar to this:
Ascii _files|formfeed. Queue_on_Port 1:\
S p=: mx#0: r mepserver 1: r p=MYQUEUELF1: \
: sd=/ usr/ spool / nyqueuel f 1:\
;1 f=/usr/spool / nyqueuel f 1/ queue. | og

Q Important ¢ Each printcap entry must have a different spool directory to work
= properly.
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System V Queue Installation

Configuring Operating System V Queue for ZebraNet Printing

This section describes the configuration of the printing system on the UNIX operating
system. For clarity and brevity, the following specific names are used to represent
general devices or concepts.

| j 4—Thelocal queue name on the UNIX system to which you want PSII print jobs
directed.

ZEBRAPRI NTER—The host name or | P address of the remote system that is the PSII
device. For example, to Telnet to the PSII and invoke the PSII configuration utility,
you would enter:

Tel net ZEBRAPRI NTER
A host name is not required for the PSIl—the | P address can be used.

your queuename—Thisisthe name of the queue on the ZebraNet and must end
with LF1.

Prerequisites

Before you proceed, the following prerequisites must be met:

¢ Thename ZEBRAPRINTER and the | P address assigned to the PSII arein the /etc/
hosts file on the UNIX system.

e The LPD must be running on the UNIX system.

UNIX Configuration

1 Logintothe UNIX machine asroot.
2 Type

| psystem -t bsd ZEBRAPRI NTER
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3 Type
| padmn -p Ij4 -s ZEBRAPRI NTER! your queuenane -
4 Type
accept |j4
5 Type
enable [j4
6 Try printing by typing the command:
lp -d Ij4 [fil enane]

PrintServer Il User and Reference Guide
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CHAPTER 6

Using Printing Protocols

In this chapter you are given steps to set up your PSII to support I nternet Printing
Protocol (IPP). Also, an exerciseis provided to experiment with File Transfer
Protocol (FTP) support.

Content
] = = 72
I 73
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IPP

Q Important  You must have | PP support on your system.

IPPisan application-level protocol used for distributed printing over the Internet.
Using IPP from any standard IPP client, you can transfer jobs to a printer that is
connected to your ZebraNet PSII device and the Internet.

Q Important ¢ |PP support is not available on all PSII printers. To be certain you are
= running the latest version of firmware, visit our Web site:

www.zebra.com

1 Open abrowser.
2 Enter the PSII IPP URL asfollows:

http://xXXX. XXX. XXX. XXX: 631/ i pp/ portl

XXX. XXX. XXX. XXX = the | P address of the PrintServer |1

devi ce

:631 = a fixed val ue

[ipp = a fixed string designating |IPP
/portl = a fixed val ue

=) Example ¢ Your address might look like this:

htt p: 198. 60. 248. 120: 631/i pp/ port 1

{% Note * Because IPP does not have an official standard, usage depends entirely on
the quality of the IPP client and server.
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FTP

Embedded within the PSII isan FTP server application that processes file transfers
from ahost computer to the printer.

If the printer is on a network, label formats can be generated and data can be
transferred without setting up a print queue.

1 Inatext editor, generate the following ZPL 11 code:
A XA
AFQO100, 100
ACFO, 55"FDZebr a Technol ogi es"FS
XZ

2 Savethefileand nameitt est .t xt .

3 Openthe MS-DOS Command Prompt and type:
ftp <IP of PrintServer I1>

=) Example ¢ If the |P address of your PSII deviceis12. 3. 4. 123, you would type:

ftp 12.3.4.123

This opens a session with the FTP server.

@ Note ¢ The default user nameisbl ank.

4 Typeyour user name and press Enter.
5 Type

put test.txt
Thistransferst est . t xt to the printer, and the printer generates alabel.
6 To terminate the FTP session, type:
quit
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APPENDIX A

PrintServer I1I

This appendix provides you with details on the PSII features that were not covered in
the chapter Getting Sarted on page 27.

Contents
PSIIFeatures .......cvviiiiiiinnnnnnn 76
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PSII Features

This section coversfeatures availablefor the PSII only, not the printer’s features. Some
of the features you access in this section prompt you to enter the default user 1D and
password, as follows:

e User ID:adm n
e Password: 1234

The options on the Print Server page vary. ZPL and EPL printers print server settings
vary dlightly.

@ Note ¢ The difference between ZPL and EPL isthis:

e ZPL—If you have a ZPL printer, you areinitially prompted to the
Printer Home page, and from there, you select Print Server Settings.

e EPL—If you have an EPL printer, you are immediately prompted to
the Print Server page.

Status and Configuration

The stepsthat follow are based on the navigation of aZPL printer using firmware X.10
or higher.

Q Important « You can upgrade your firmware by visiting our Web site:

http://www.zebra.com

1 Open aWeb browser.
2 Inthe Addresstext-box, type your printer’s | P address, and press Enter.
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The Printer Home Page opens:

JEiIe Edit “iew Favorites Tools Help |

<~ = @ > Add . "
- - rass hitp://10.3.4.102/printerfindescht =
j Back FEaEryare Stop Refresh — I@ pif fprinter/index J
| Links

Zebra Technologies
ZTC 140XiII1-200d pi

Status: READY

Printer Home Page

View Printer Configuration
View and Modify Printer Settings
Directory Listing
Alert Setup
Printer Controls

Print Server Settings

Home: HTTEWWACW L ZERRA COM
Support: HTTEASUPPORT ZEBRA COM

|@ |_|_|ﬂ Internet
3 Fromthe Printer Home Page, click Print Server Settings.

N

Q Important ¢ Theillustration of the Printer Server Settings page is based on a ZPL
printer. If you have an EPL printer, the menu options on the Print Server page are

dlightly different.
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The PrintServer page opens.
A http:/10.3.4 1024server] - Microsoft Internet ... [=1F3

JEiIe Edit Miew Fawvortes Tools Help

.= @ [

Back SErEtnl stop Fefresh

ol

|,&gdress

Focus - ZebraNet PrintServer

Status and Configuration
Printer
Print Jerver

Print Johs

JobLog
Cancel JToh

Print Server Status
View Conficuration Sheet
View Port Status

Support
Contact
FAQ
Updates

Reset
Reset Printer
Eeaet Print Setver

Restore

Factory Default Printer Settings
Factory Print Server Settings

|@ Done | | |¢ Internet

B

4 From the PrintServer page, click Print Server.
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The Print Server Configuration page opens:
A http:1110.3.4.102/serverimenu_ htm - Micr... [I[=]1E3

JEiIe Edit Aiew Faworites Tools Help |

>
- > = @ Address
Back A Stop

Focus - ZebralNet PrintServer

Print Server Configuration

Enabled Protocols
Hetware

TCPAR Confisuration
TCPAP Logical Printing Ports
Syratem (SHLE)

[P &letts (Traps)
[P Alerts (Traps

ELITE Email Aletts
Web & dimin
POP3 E-Iail Printing

| Home | Print Server Config |

|-
|@ Done |_|_|* Internet i

PrintServer Il
PSII Features

Inthe Print Server Configuration page, you have amenu to choose from. Thetable

that follows identifies what each menu option page looks like:
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Enabled Protocols

Modifies the protocols to be used.
NetWare, HP JetAdmin, or both.

Enabling HP JetAdmin Support allows
status from the Zebra device to display in
Hewlett-Packards HP JetAdmin utility.

Netware

Preferred Tree—Enter the tree that the
printer isin.

Print Server Name—Enter the name of the
printer.

Disable NetWare SAP—Enables or
disables the broadcast SAP (Service
Advertising Protocol) messages. Typically,
SAPisenabled. If SAPs are disabled, the
print server does not appear in the bindery
and is not discovered by ZebraNet View.
Disabling SAPs reduces network traffic,
however, SAPs should be disabled, only on
networks using NDPS exclusively or
NetWare 5 over the I P protocol.

NetWare Frame Format—You can select
how the frames for the data packets are
assembled. The default is Automatic
Sensing.

For details, see Help.

Ahttp 1110 3.4 102/server/PROTOCOL htrn  I[SIEY

JE\Ie Edit Miew Favorites Tools Help

>
O S | Addrass
Back el iz Stop

Focus - ZebraNet PrintServer

Protocol Configuration

=3
Profocols: ¥ Hetware

¥ HP et dmin

Submit Changes

Home | Print Server Config
Frinter Config

s

|€| Done l_l_“ Internet

A http:#/10.3.4.102/server/PSERVER htm - .. [HEEI

JEME Edit Miew Faworites Tools Help ‘

S »HAgd[eSS

Back F=EryEre Stop Fefresh

Links

Focus - ZebraNet PrintServer

PServer Mode Configuration

NDS Settings

Preferred Tree: |

Print Server Name:

Other
Queue Scan Time(1/10 secs): |40
Mo =

Disable Neiware SAP:

Tetware Frame Format: | Automatic Sensing =

Metware Password: |

Confirm Neiware Password: I

Submit Changes |

Home | Print Server Config
Printer Config | M
»

<
|@ Daone ’7,7“ Internet i
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TCP/IP Configuration

You can change the TCP/IP Configuration

of the PSII.
For details, see Help.
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File Edit ‘“iew Favortes Tools Help |

=5 »
) Address
Back e Stop Reftash

4110.3 4 102)server/TCPIPGEN htm - [H[=1E3

Lirks

Focus - ZebraNet PrintServer

TCP/IP Configuration

TP Address: [10.3.4.102
TP Address Resolution: | Dynamic VI

Dynamic Protocols:  [7 papp
¥ BootP
¥ DHCP
™ Gleaning
™ Default Address

Submet Mask: |255.255.256.0
Default Gateway: [10.3.4.1
WINS Server IP Address: |10.3.1.15

Comnection Timeout Checking: |YVes =

Timeout Value (secs):  [300

=

ARP Broadcast Interval (mins):

Base Raw Port Number: (9100

Submit Changes

Home | Print Server Config
Printer Confix

@ Dane ’_l_lﬂ Intemnet

ol
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TCP/IP Logical Printing Ports

Logical printers allow you to set up
multiple pre- and post-processing
configurations for each output port. Each
logical port configuration can do the
following:

e Add user-configured strings before and
after the print data.

¢ Remove unwanted characters from the
beginning of the print data.

e Four logical printer configurations are
supported for each output port on the
printer. The configurations can be
assigned to any port, and all of these con-
figurations can be assigned to asingle
output port.

System (SNMP)

This feature gives you the ability to
manage multiple devices on a network, be
it printers, computers, or other network-
attached devices.

On this page you can define the SNMP
system name, system location (PSlI
description), and other SNMP settings for
your PSII.

A http-#/10 3 4 102/server/MLP htm - Micros__ [Hl[=] 3
JElIe Edit “iew Favorites Tools Help ‘

- »
=g = ) Address
Back e Stop Refresh

Focus - ZebraNet PrintServer

Logical Printer Port Configuration

Logical Port 1 Configuration

Logical Port Name(FTP, LP): I

TCP Logical Pori Number (Raw): IU
|
|

Pre String;

Post Siring;
Delete Bytes: IU

Logical Port 2 Configuration

Logical Port Name(FTP, LP): I

TCP Logical Port Number (Raw): ID
|
|

Pre Siring;

Post String;
| _>|_I

|
|&] Done [ [ |4 inemet 4

R http:1/10.8.4.102/server/SYSINFO htm - Micros_._ =] E3
JEiIe Edit “iew Favorites Tools Help

@ s @ @

J Back T FErwarsl Stop Refresh

Lirks

”HAgdress __I

Focus - ZebraNet PrintServer

System Information Configuration

System Name: |Fucus

System Contact: |

System Location: I

Get Community Name: I””“"‘"""‘"“‘

Confirm Get Community Name: I“‘*""“"‘"’“‘

Set Conmmuity Name; ~[oeesec

Confirm Set Community Name: ===

Trap Community Name: [aublic

Confirm Trap Community Name: [public

Submit Changes
@ Done ’_’_li Internet

B
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IPX Alerts (Traps)

I nternetwork Packet Exchange (IPX) is
Netware's network-layer protocol that
handles networking addressing, routing,
and packets.

Thisfeature hasyou enter the IPX Network
Address and IPX Node Address to which
traps will be sent.

e To broadcast trapsto all addresses on all
networks, enter FFFFFFFF in the IPX
Network address field and
FFFFFFFFFFFF in the IPX Node
Address field.

¢ To broadcast traps to all addresseson a
specific local network, enter the network
number in the IPX Network Address
field and then FFFFFFFFFFFF in the
IPX Node Addressfield.

e To disable traps, set all destination
addressesto 0.

SMTP Email Alert Configuration

This feature allows you to enter data
regarding System Information on the
network that is being used. Typicaly, a
Network Administrator would use this.

PrintServer Il User and Reference Guide
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AR http:##10.3.4 102/server/IPXTRAP htm - [H=IE1

JEMe Edit Yiew Favorites Tools Help

J &0 B =] »HAgdreSS
Back e pgeire] Stop

Links

Focus - ZebraNet PrintServer

IPX Trap Configuration

IPX Network Address: 00000000
IPX Node Address: |000000000000

Specific Traps: 7 0p Line
¥ Off Line
I3 PaperOut

Submit Changes

Home | Print Server Config
FPrinter Config

S B

@ Done | | ‘0 Internet

AW htip:410.3.4.102/server;/SMTP.ht... [H=1E

JEI|E Edit Yiew Favorites Tools Help |

A~ HAgdress
Back Farward Stop

J Lirks

Focus - ZebralNet
PrintServer

SMTP Email Alert Configuration

SMTP Server Address: |10.3.11.12
Print Server Domain (optional):

Submit Changes

Home | Print Server Config
| Printer Config |

|@ Done | Fli Internet

Sl
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Web Admin

This page alows you to configure the
Admin name and password. Linksto
upgrades and support information can also
be altered.

POP3 Email Printing

This feature helps you set up the print
server to receive email messages
containing formats that can be printed. The
POP3 settings must be set to retrieve
emails from the email server.

Warning ¢ Setting the POP3 polling
interval (seconds) below 30 can cause
communication problems with the POP3
Server.

Print Server Status

84

Aihitp:f10.3.4.102/serverADMIN him - Microsoft Internet Explorer [_Tolx]|
File Edit View Favorites Tools Help

S A
Back Fomwerd Stop  Refresh

Links

HAgdress €] htip 0 3.4702/5 =

Focus - ZebraNet PrintServer

‘Web Admin Configuration

AdminName: [acmin

AdminPasswords [

Confirm Adwin Pasword: [oeees
HITPPort: i

FAQURL: [ntip/supportzebra.com

Updates URL: Iﬁp Jtp.zebra.comfpubfpmt_sn

Custom Link Title:

Custom Link URL: [

Submit Changes

SN [EE

‘@Dune ‘ | ‘a Internet

Al hittp:/110.3.4.102/serverfPOP3 htm - Microsof._.. [H=IE]
JEME Edit Wiew Favorites Tools Help

= _ @ (4

j Back | Fumwerd Stop  Refresh

j Links

»HAgdress

N

Focus - ZebraNet PrintServer

POP3 Printing Configuration

POP3 Sexver Addvess: |0.0.0.0
POP3 User Name:
POP3 User Password:

POP3 Polling Interval (seconds): |0

Submit Changes

Home | Print Server Config
Printer Confix

‘@ Dane lil |C Internet

RN

From the Print Server page, in the Print Server Status section you can access PSII’s

configuration sheet and port status.
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e From the PrintServer page, click View Configuration Sheet.
This page opens:

& »
®« . 0 9 Address I@ htp: vl Links
Back eIl Stop Fefresh
-
. 1 .
Focus - ZebraNet PrintServer

General

Serial Number: 1925107

Ethernet Address: 0040551D5BAR Cable Type: 10BASET

Speed: 10Mbps Link Status: Good

F/W Version: .30 (A0DZ14) Polarity: HNormal

Fx Packets: 5946 Tx Packets: 280

Fx Packets Unavailable: 0 Tx Packet Errors: 0O

Fx Packet Errora: o Tx Packet Retries: 0O

Checksum Errors: 127
Error:

NetWare: Hone

TCR/IP: Hone
HetWare (EHABLED)

Hode: Unknowm

Print Server Name: ZER15925107

SAP Interval: 1 Mimate

Frame Format: Ethernet 802.3

Trap Destination: 00.00.00.00 : 00.00.00.00.00.00
TCP/IP (EHABLED)

Systen Name: Focus

Web Address: http: //10.3.4.102

IP iddress: Using network protocol { 10.3.4.102 )

IF Address Source: DHCP serwer 10.3.1.15

Boot Protocols: RARF EOOTP DHCP

Subnet Mask: 255.255.255.0

Default Gateway: 10.3.4.1

Timeout Checking: Enahled

Trap Destination(s): 255.255.255.255 |
JetAdmin (EHABLED})
Port Configuration

Hame: Focus

Printer Jtatus: Online

Lancuage Switching: 0ff

Comnected To: printer - ZTC 140XiIII-Z00dpi il
4| | ¥

|@ Dane |ﬂ Internet i
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Q Important « The default user ID and password is required to access this page.

Reset

86

e From the Print Server page, click View Port Status.

The port status page opens:
Aihttp//10.3 4.102/server/STATUS htm - Micr .. [Hi[=E3

| Eile Edi

Wiew Faworites Toaols Help

-
Back,

-

5 2

R = Stop Fefresh

>

j,&gdress

Focus - ZebralNet PrintServer

Parallel (1284 Nibbhle) Port 1

Printer Status: Online

Printer Model: ZTC 140EHTT-200 dpd

Home | Print Server Confis
Printer Config

|_|_|ﬂ Internet

N

From the Print Server page, in the Reset section you can reset PSII’s configuration
settings to what they were before you made the most recent changes.

1 Fromthe Print Server page, click Reset Print Server.
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The Reset Device page opens:
Al http:/110.8.4.102/serverfRESET htm - ... [H[=1E3

JEiIe Edit Miew Faworites Tools Help |

»
« .5 D Address
Back f=arEro Stop

Focus - ZebralNet PrintServer

Reset Device

Reset the device?
Yes |

| Home | Print Server Config |
Erinter Confis

|@ Dane |_|_|ﬁ Internet

2 Toreset PSII, click Yes.

N

Restore

From the Print Server page, in the Restor e section you can restore PSII’s to the default
factory settings:

1 Fromthe Print Server page, click Factory Print Server Settings.
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The Restore To Factory Defaults page opens.
N} http:#10.3.4.102/serverRESTOR ... [M[=] 3

JEiIe Edit iew Fawvorites Tools Help |

b
< s D Address
Back R =i Stop

Focus - ZebralNet
PrintServer

Restore To Factory Defaults

Restore: [~ ]l Settings
[ TCPAP
M HetWare

Submit Changes

| Home | Print Server Config |
Printer Config

[ <]
|@ Caone |_|_|Q Internet i

2 Makethe selections you want, and click Submit Changes.
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APPENDIX B

Zebralink

The appendix provides you with detailed information that allows you to use the
enhanced functionality of your Zebral ink-enabled printer with the PSII.

Contents
WebView . .. .oi ittt i it e
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WebView

WebView

WebView gives the System Administrator or user who needs complete, easy, one-step
control over the printing environment exactly what is needed. It provides rea-time
configuration, control, and monitoring capabilities with the convenient graphic
interface of a Web browser.

The Web pages returned by Zebra printers are not static. They contain real-time
information about the printer’s present state of operation, including on-line status,
error conditions, and all printing parameters.

Home Page

&3

90

Note  To access the printer’s Web page, you need the IP address. For instructions
on getting the I P address, see Assigning an |P Address on page 30.

The Home Page is the first Web page that opens. It is a page with a menu of
hyperlinks. Each hyperlink allows you to make modifications to the printer, PSII, and
network settings; the other changeable settings through the Home Page include:

¢ Network Status, Error, and Warning reports

o ZebraNet PSII configuration

e Printer settings

¢ Directories of objects stored in Flash memory and RAM devices

e Objects, stored fonts, images, programs, and ZPL |1 formats

e Zebra Technologies support and home pages

1 Open aWeb browser.
2 Inthe Addresstext-box, type your printer’s | P address, and press Enter.
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The Printer Home Page opens:

AR ZTC 140Xill1-200dpi - READY - Microsoft Internet Explorer

JEiIe Edit “iew Favorites Tools Help |

j@,-»,@

Back eIl Stop Fefresh

JAereSS I@ http:,-",-"1D.3.4.1DZ,-"printer,-"index.htj

| Links

-

8

Zebra Technologies
ZTC 140XiII1-200d pi

Status: READY

Printer Home Page

View Printer Configuration
View and Modify Printer Settings
Directory Listing
Alert Setup
Printer Controls
Print Server Settings

Home: HTTEWWACW L ZERRA COM

Support: HTTPA/STPPORT. ZEBEA COM

N

|@ |_|_|ﬂ Internet

View Printer Configuration

ZebralLink
WebView

The View Printer Configuration menu option provides accurate, up-to-the-minute
information on the printer’s current state. An administrator can conveniently find any
information on the Virtual Configuration Label and also check on the status of printer

ports.

1 From the Printer Home Page, click View Printer Configuration.
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The WebView displays the configuration settings:
AR ZTC 140Xill1-200dpi - View Printer Configuration - Microsoft Inter... [H=]Ed

JEiIe Edit “iew Favorites Tools Help |
SR
Back eIl Stop Fefresh

| Links

JAereSS I@ hitp:/#10.3.4.102printer/confi j

Zebra Technologies
ZTC 140XiII1-200d pi

Home

View Printer Configuration

92

Ne27

HEATD RESTSTOR

+13 DARFNESS

-01z TEAR. CFF

TEAR. CFF FPRINT MCDE
NON-CONTINTOUS HEDIA TYPE

WEE SENSOR TYFE
DIRECT-THERMAL PRINT METHCD |
101 4/8 MM FPRINT WILDTH
1zez LABEL LENGTH
7.0IN 177MH HMAXIMNUM LENGTH
PARALLLEL PARALLLEL COMH.
R3Z3E SERIAL COMH.
Q600 BALUD

7 BITS DATL BITS

EVEN PARITY

1 3TCP BIT STOP BITS

EON/ ZOFF HOST HANDZHALEE
NONE PROTOCOL

ooo NETWORE ID
NORMAL MCDE COMMUNICATIONS
<~» TEH CONTEROL PREFIX
<*» EEH FORMAT PREFIX
<,» ZCH DELIMITEER CHAR
ZFL II ZPL HMODE

FEED HEDIA POUWEER UP
FEED HEAD CLOSE
DEFAULT BEALCKEFEED

+000 LABEL TCP
+0000 LEFT POSITION
aooo HEAD TE3T COUNT

|@ Dane

|_|_|i Internet

LKL

2 To update the printer information from this view:

3 When you are finished reviewing:

» For Netscape, select Reload and the printer sends current information to the

Web browser.

» For IE, click Refresh and the printer sends current information to the Web

browser.

* Toreturn to the Home page, click the Home link.

» To print the label, scroll to the bottom of this page and click Print Label.
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View and Modify Printer Settings

This section provides you with steps for accessing and modifying printer settings with
aZebral ink-enabled printer. It also providesillustrations of the various pages you can
access.

Q Important » To apply changes made in this section, you need to use the default user
= ID and password:

User ID: adm n
Password: 1234

1 From the Printer Home Page, click View and Modify Printer Settings.
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2

The View and Modify Printer Settings page opens.

JEiIe Edit “iew Favorites Tools Help

&
Back

> 0D

AN ZTC 140Xill1-200dpi - View and Modify Printer Settings - Microsof._. [H[=] 4

[EarwaErd Stop Refresh

jAgdress [&1 pin10.3.410270rintersetings ]

| Links

Zebra Technologies
ZTC 140XiIII-200d pi

Home

View and Modify Printer Settings

General Setup
Serial Communications Setup
Network Cominunications Setup
Print Listings on Label

Media Setup
Calibration
ZPL Control

Advanced Setup

ENTER PASSWORD

Sawve Current Configuration |

Restore Saved Configuration |

Restore Default Configuration |

]

Home: HTTPMWCACA ZEBRA COM
Support HTTPASUPFOET ZEBE A CCOM

|

[ [ |4 intemet

4

[ |

In the View and Modify Printer Settings page, you have a menu to choose from.
The section that follows identifies what each menu option page looks like:
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General Setup

Serial Communications
Setup
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|2l ZTC 140Xi111-200dpi - General Seitup - Microsoft Internet Explorer [—1olx]|

File

ZebralLink
WebView

Edit View Fgvorites Tools

= -

Bock | Fomward

Address -
SEo  m H d [&1 hpn 034102 /primersetgen =

Zebra Technologies
ZTC 140XiIM-200dpi

Home

General Setup

Prinier Name

Printer Description

LANGUAGE
ENGLISH ~

DARKNESS
Range 0 1090
13

TEAR OFF
Range -120 10 120
[z

PRINT MODE

TEAROFF =

LABEL TOP
Range 12010 120
o

LCD ADJUST
Range 0 10 19
10

ENTER PASSWORD

Submit Changes

Reset Changes

|4 Intemnet

&7 Done

rosoft Internet Expl

A ZTC 140Xil11-200dpi - Serial Communications Setup
Help

? Add -
Fsiresh ddress [&) hp710.34 T02/printerzetcom 7]

File Edit W¥iew Favortes Tools

& -

Back fFonyard Stap

Zebra Technologies
ZTC 140XiI0T-200dpi

Home

Serial Communications Setup

BAUD
4600 =
DATA BITS

7EITS =

STOP BITS
1STOPBIT v

PARITY

EWEN =

HOST HANDSHAKE

XONXOFF 3

PROTOCOL
NONE v

SERIAL COMM.
RS232 A

NETWORK ID
Rarge 010999

o
ENTER PASSWORD

Submit Changes

ResetChanges

NlE

[ termet

@] Done
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ZebralLink

WebView

Network Communications
Setup

Print Listings on Label

|l http //10.3.4.102/server/TCPIPGEN hitm - Microsoft Interne... IMI=IEY

FEile Edit View Favorites

Tools Help ‘

o

Back | Forward Stop

= . @ [3

Refresh

Links

”AgdresS & http10.3. =

Focus - ZebralNet PrintServer

TCP/IP Configuration

IP Address: [103.4.102
IP Address Resolution: [Dynamic |+

Dymamic Protocols: | Rarp

I Bootp

¥ DHCP

I Gleaning

I Default Addeess

[e8Bes52560
[osar
[ozias
e
ARP Broadcast Interval (mins): [0
| X

Submit Changes

Subnet Mask:

Default Gateway:

WINS Server IP Address:
Connection Timeout Cheeling:

Timeout Value (secs):

Base Raw Port Number:

Home | Print Server Config
Printer Config

@] Done

w

| 4 imtemet

ZTC 140Xil11-200dpi - Print Li

File Edit “iew Favorites

Tools Help |

&
Back

> .

~ Links
Forward Stop  Refresh

»HAgdreaa'—‘

Zebra Technologies
ZTC 140Xil11-200dpi

Home

Print Listings on Label
LIST FONTS
LIST BAR CODES
LIST IMAGES |
LIST FORMATS I
LIST SETUR
LIST ALL I

Home: HTTP/ARATW ZEBRA COM
Support: HITP/SUPPORT . ZEBRA COM

&1 Done

N[E

[T [ ntermet
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Media Setup

Calibration
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2 ZTC 140Xill1-200dpi - Media Setup - Micro... [H[=1E1

FEile

ZebralLink
WebView

Edit View Fowortes Tools Help ‘

=

Back | Femvard

Links

Address

> =
Siop  Refresh

Zebra Technologies
ZTC 140XiIII-200dpi

Home

Media Setup

MEDIA TVPE
MNOMN-CONTINUQUS [+

SENSOR TYPE
WEB =

PRINT METHOD
DIRECT-THERMAL =

PRINT WIDTH
Rarge 2 to 2000
512

MAXTMUM LENGTH
Range 406 10 7917

[1421

ENTER PASSWORD

Submit Changes
Reset Changes

Home: HTTP./WW/W ZEBRA COM

NE |

Stnnnrt: HTTR-/51TFPORT ZFRRA COM

|4 Internet

&] Done

Calibration - Micr._. [EI[=IE3 |

Tools  Help ‘

File Edit Yiew Favorites
& = “Agdress

Back | Fomvard | Stop

JLmks

Zebra Technologies
ZTC 140Xill1-200dpi

Home

Calibration
MEDLA POWER UP
FEED =

HEAD CLOSE
FEED -

Weh Sensor
Range 0 to 100

E|

Media Sensor
0to 100

F'

Ribhox Sensox
Range 0 to 100

§|

Mark Sensor
Range 0 to 100

-

Mark Media Sensor
Range 0 to 100

-

Media LED Brightess
Range 0 to 255
B

.

Rilbon LED Brightness

N

&oone \ | et
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ZebralLink
WebView

ZPL Control _ : -
|82TC 140Xill-200¢pi - ZPL Control -... MIEII|

Eile Edit Yiew Favortes Tools Help
- = @ HAgdreES

Back Fonyard Stop

Links

Zebra Technologies
ZTC 140XilI1-200dpi

Home

ZPL Control

CONTROL PREFIX
Range 0 to FF Hex

Fe

FORMAT PREFIX
Range 0 10 FF Hex
SE

DELIMITER CHAR
Range 0 10 FF Hex
2C

ZPL MODE

ZPLI =

ENTER PASSWORD

Submit Changes
Pieset Changes

Home: HTTP//WWW ZEERA COM b=
Suppork HTTE.#SUPPORT ZEBRA COM =l
A

&] Done | o Intemet

Advanced Setup B ZTC 140Xil11-200dpi - Advanced Set_ IIEIE |
|

File Edit “iew Favortes Tools Help

B =S D “
Back Fonard Stop

ZTC 140XiHIIT-200dpi |

Home

JAgdress J Links

Advanced Setup

BACKFEED

DEFAULT =

LEFT POSITION
Range 9990 to 9999
0

FORMAT CONVERT
NONE -

HEAD TEST COUNT
Razge 0 1o 9999
0
HEAD RESISTOR

Range 482 to 2415
528

INITIALIZE CARD
Initialize Flash Memaony

VERIFIER
OFF -

APPLICATOR
OFF =

ENTER PASSWORD

Submit Changes

ResetChanges |

|4 Intemat

Sl

@] Done
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ZebralLink
WebView

Directory Listing

The directory page provides alisting of all file system devices (B, E:, R:, Z:). The
size, name, and location of each stored object appears.

Buttons are available to perform file management operations on the objects. Thefile
management operations include:

» Delete object—Not available for objects in read-only memory (Z:).

» Copy object to anew name and/or device—Not available for objectsthat have
the “protected” attribute set.

e RunaZBI program—Available only if the object isastored ZBI program. For
details, see Zebra BAS C Interpreter (ZBI) on page 105.

1 From the Printer Home Page, click Directory Listing.
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ZebralLink
WebView

This page opens:

2N ZTC 140Xilll1-200dpi - Directory of: E: R™** - Microsoft Internet Exp... =] B4
JEi\e Edit “iew Favarites Tools Help |

‘@v»v@ >

Address tta; i i v|
Bac Farwar S Eefrash j I@ h p.,-”,-"]D.3.4.1D2,.’pr|nter,r’d|r
J Links

[ |
Zebra Technologies

ZT1C 140XiI11-200d pi

Home

Memory Status

tDevice| Type tB}_'tes Free tB}_'tes Total
| E |OMBOARD FLASH| 1569100 || 1572864
[ & | EAM [ 3094508 || 3145724

Devwice: IE: F: (User devices) ;I Type: |_* {ny ohjact) ;l M

Directory of: E: R:*.*

|.'—\linse-s| Name LBy'tes [ﬁngs| Actions
| REASICmem.CO [51216 [ Delete || Copy ||

| EMAILBAS || 3532 [ Delete || Copy ||
|

EAUTOEXEC ZPL| 44 | Detete | Copy || Print on Label

Create Mew Script |

Home: HTTP /AW WW ZEBRA CO
Support HTTEWSTPPORT ZEREA COM

|&] Dane [ 8 ntemet

2 Therearesevera linksto select in thisview.
3 Tocreateascript, click Create New Script.

I

Alert Setup

To configure the printer’sinteraction with ZebraNet Alert to be completely functional,
SNMP settings must be established in these areas:

e The printer, viathe WebView interface.
e TheAlert Printer Management Utility for logging SNMP traps.

The Zebral.ink messaging system provides for more than SNMP notification. Alert
can be routed to various destinations:
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ZebralLink
WebView

e TCP

 UDP

o emall

» serial port

» paralel port destinations

1 From the Printer Home Page, click Alert Setup.
The Alert Messaging System page opens:

ZM ZTC 105SL-300dpi - Alert Mes — ol x|
J File Edit “iew Favorites Tools Help ﬁ
| +Back ~ = ~ @ at | D search EFavorites @History | >
| Address [&1 htp: //10.3.4. 149/printer funs ~|||Links »

.

Zebra Technologies
ZTC 105S1L.-300dpi

Home

Alert Messaging System

| Condition lDestination|SET|CLR|Address lPurtlA.ctions

[(AYyPAPER OUT | TCP | ¥ | ¥ [10.34.118] 0| Delete

(A PAPER OUT |[FrSHMP | ¥ | ¥ [10.3.4.118] 0| Delete

[B) RIBEON OUT|F) SHMP | ¥ | ¥ [10.34.118] 0| Delete

[BE) HEAD OFEN [F)SHMFE | ¥ | ¥ [10.3.4.118] 0| Delete
Add Aert MMeszsace

Home: HTTECATW W ZEBRA OO
Support: HITEWSTUPPOERET. ZEBRA QO

|@ I— I— @ Internet

2 Toaddan alert, click Add Alert Message.
3 Select accordingly.

NI

Establishing Email Alert Messaging

ZebraNet Alert supports email notification of printer errors sent directly to any valid
email address. You can have multiple email addresses set up for routing different error
messages, or split notifications between email and other network management tools.
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ZebralLink
WebView

1 From the browser, in the address text-box type in the printer’s address.
The printer’s home page opens.
2 Fromthe Printer Home Page, click Alert Setup.

The Alert Setup page shows alist of message notifications and their respective
destinations.

3 Fromthe Alert Setup page, email notification can be set up. Click Add Alert
Message.

The Add Alert Message page opens:
A ZTC 140XillI-200dpi - Add Alert Me__ [HI=] E3

JEiIe Edit iew Fawvorites Tools Help |

>
= . = @ Addrass
Back ] i) Stop

Zebra Technologies
ZTC 140XilII-200dpi

Home

Add Alert Message

Condition: I FAFPER QOUT ;I

Destination: ISERlAL Vl
3ET: IYES vI
CLE: IYES VI

Address: I

Port: I

Add Alert Messane |

Password I

Alert Setup

Home: HTTE /MWW ZEBR A COLI
Support: HTTEASUPPORT ZEERA COM

@ | | |4 inemet

N[ B
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ZebralLink
WebView

Q Important « The printer accepts only the last configuration made.

4

5

Specify the condition to send over email, such asHEAD ELEMENT BAD or
PAPER OUT.

Enter avalid email address for the messages to be sent.

=) Example ¢ adm n@our conpany. net (The Port field can beignored for
email setup.)

6

Warning ¢ You must type in a password. If you forget to enter the default
password, the alerts you just set are deleted.

Click Add Alert Message. Here you can continue to add more settings or, if
finished, save the current settings.

From the Printer Home Page, select PrintServer Settings>Network
Communications Setup.

Click SMTP Email Alerts.
Specify your SMTP server address.

When these steps are done, you can begin receiving email notification messages.

Printer Controls

This page offers control over basic printer functions.

Other functions are also accessible from this page. These include:

1

» Feed—causes printer to feed one label.
« Cancel One For mat —cancelsthe currently printing format.
e Cancel Al Format s—cancelsall formats.

 Reset Printer—causesprinter to perform its standard reset without
cycling power.

From the Printer Home Page, click Printer Controls.

PrintServer Il User and Reference Guide
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ZebralLink
WebView

This Printer Controls page opens:

AR ZTC 140Xill1-200dpi - Printer Controls - Microsoft Int... [Hi[=lE3
J File Edit ¥iew Favorites Tools Help |

- = @ ” Add
A v ressl hitp:/#10.3.4 vl
j Back Figiz| Stop  Refresh - &1 htp

| Links

Zebra Technologies
ZTC 140XiII1-200d pi

Home

Printer Controls

ENTER PASSWORD

Fause |
Feed |

Cancel One Format |

Cancel All Farmats |

Feset Printer |

Home: HTTEWWACW L ZERRA COM
Support: HTTEASUPPORT ZEBRA COM

|@ |_|_|e Internet

N

Q Important ¢ In this view, you must have administrative rights to make changes to
= the printer controls.

Print Server Settings

This section provides you with instructions for viewing the current printer settings.

e From the Printer Home Page, click Print Server Settings.
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The PrintServer page opens:

AR http:#110.3 4.102{server] - Microsoft Internet__ [M[=1E3
JEiIe Edit Yiew Fawvortes Tools Help |

J N N < »JAgdreSSE

Back Rzl Stop Fefresh
| Links

|»

Focus - ZebraNet PrintServer

Status and Configuration
Printer
Print Server

Print Jobs

Job Log
Cancel Job

Print Server Status
Wiew Confisuration Sheet
View Port Status

Support
Contact
FAQ
Tpdates

Reset
Reset Printer
Eeset Print Zerver

Restore
Factory Default Printer Settings
Factory Print Server Sethngs

|@ Done ,_’_|¢ Internet

S E

For more details on PSiIlI, see PrintServer 11 on page 75.

Zebra BASIC Interpreter (ZBI)

ZBI alows you to maximize printing options through custom programs written for

ZebralLink
WebView

your specific needs. ZBI programs can be viewed, modified, and run from the
Directory Listing Page. Directory Listing on page 99.

PrintServer Il User and Reference Guide
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ZebralLink
WebView
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APPENDIX C

ZebraNet Utilities

The appendix provides you with details on ZebraNet Utilities, the software suite of

printer administration tools that complements and enhances both Zebralink and the
ZebraNet family of connectivity products.
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ZebraNet Utilities
ZebraNet View

ZebraNet View

ZebraNet View allowsyou to locate printers automatically. It can search on parameters
such as | P address, subnet, printer model, printer status, and many other user-defined
characteristics. It aso offers powerful device management capabilities.

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.
The ZebraNet View dialog opens:

Y.< ZebraNet View - Zebra Technologies Corporation

J Eile ErintServer Yiew Tools Help |

| @ Oz =6

B R IR

System Mame © | IPAddressl Hid Address | Serial # | Subnet Mask | Default Ga... | Product Type Froduct# | Datecode | Status

B Focus 1034102 00406810D6BAB 1928107 255.256.255.0 10341 ZebraMet PrintServer 46686 AOZ1A, Warning

10. 4 004068104935F 1 ZebraMet Pri reer 46687 Good

fZPL Hybrid 10 9 004068109354 50 10341 ZebraMet PrintServer  46R87 Good

FaorHelp. press F1 |Court: 3 |Protocol: TCRAP  [Wiew: ZGN i

2 Select your printer.
3 From the menu bar, select PrintServer>Configuration.
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The Print Server Configuration dialog opens:

Print Server Configuration-10.3.4.102

TCFAP |E|ut|:|ut F'u:nrtl SNMF'I F'n:ntou:u:nlsl SHMP Trapsl

— P Addresz Resalution

= Use Metwork Protocal
M ethods: = Al Timme sk
I#| EARE
I B
¥ DHER
¥ Gleaning

ZebraNet Utilities
ZebraNet View

| 255 . 255 . 285 . 0
[ 10,3 .4 1

WIMNS Server I m. 3 .1 15
¥ Lse DHCR ToLocate WINS Senver

Subnet Mask:

Diefault G ateway:

TelnetHitp Pazsword | Advanced TCPAP

0k, I Cancel |

Help

PrintServer Il User and Reference Guide

There are multiple tabs that you can access to make changes to current settings.

4 From the Print Server Configuration dialog, click the SNMP Traps tab.
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ZebraNet Utilities
ZebraNet View

The SNMP Traps tab shows the aerts you can set.

Print Server Configuration-103.4.149 [

TCPAP | Output Port | SNMP | Protocols  SNMP Traps |

Protocal: BRI hd

— Trap Destination

TCR/IP Address:

Parts To Trap Frinter Trapz

| 255,255,255, 255 ~|  Edi

Bemaove

Ik

[w|Piort 1 [w|Or-line [Condition cleared)
[w?] O ff-lire

[w]Paper Out

[w] Printer Error

The check
boxes in
Printer Traps
are the alerts.

Ok, I Cancel |

Help |

5 To monitor the set aerts (printer traps), see ZebraNet Alert on page 111.
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ZebraNet Alert

ZebraNet Alert gives you the ability to manage your Zebra printers by immediately
notifying System Administrators of printer error or warning conditions. Using Web-
based configuration tools, selected errors or warning conditions can be routed to a
variety of services such as email messages, wireless pagers, or the ZebraNet Alert.

The following tables show the conditions that can trigger alerts:

PSII Alerts

On-line (condition clear)

Off-line
Paper out

Printer error

ZebralLink Alerts

Media out

Ribbon out

Printhead over-temp warning
Printhead under-temp warning
Head open

Power supply over-temp
Ribbon warning (in direct-therma mode)
Rewind full

Cut error

Printer paused

PQ job completed

PrintServer Il User and Reference Guide
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ZebraNet Utilities
ZebraNet Alert

o Label taken
e Head element out

e ZBIl (ZebraBASIC Interpreter) runtime
error

o ZBIl (ZebraBASIC Interpreter) forced
error

e Power on

ZebraNet Alert Destinations

Unsolicited Alert messages can be directed to the following destinations:

Email (PSII-specific)

Serial (Zebralink-specific)
Paralel (Zebral ink-specific)
TCP (PSlI-specific)

UDP (ZebraL ink-specific)
SNMP (PSlI-specific)

ZebraNet Alert Using SNMP

You can send notifications over SNMP only, for use with ZebraNet Alert or asimilar
network management utility.

Q Important ¢ If you did not install ZebraNet Alert during the ZebraNet Utilities

1
2

112

installation, see ZebraNet Utilities on page 19.

From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View.
Select the printer you want.
» |f aDHCP server is present, the PSII will already have an | P address.
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ZebraNet Utilities
ZebraNet Alert

* |f no DHCP server is present, you might need to assign the printer an IP
address.

3 Toassign your printer an |P address, from the menu bar, select Print
Server>Configuration.

4 For PrintServer SNMP Traps, select the SNMP Traps tab.
5 Enter the trap destination and options.
Thistells the PSIl what TCP/IP address to send the aerts to, and under what

circumstances to send error and log reports. Entering 255.255.255.255 broadcasts
the message to every host on the network with an SNMP program running.

6 For ZebraNet Alert to get and display the messages, you need to open ZebraNet
Alert. To do this, follow these steps:

* From thetask bar, select Start>Programs>ZebraNet Utilities>ZebraNet Alert.

Q Important « The SNMP trap settings must be established to communicate with PSII
= if messages are sent to the ZebraNet Alert.

¢ Inthe ZebraNet Alert dialog, from menu bar, select View>Filter Settings.

e From the View Filter - Devices tab, choose your settings accordingly.

@ Note « If you select No device filtering, messages from every printer are caught;
Device Address allows you to specify which IP address data will come from.

e TheView Filter - Eventstab allows you to select individual events you want the
program to be aware of.

Q Important « Now PSII’'s SNMP Alert messages can be set up in WebView. From
= the printer’s home page, activate the link to Alert Setup. You can add messages that
are sent to the ZebraNet Alert for Windows by choosing SNMP as a destination.

Sending Email to Your Zebra Printer

To eadly transfer instructions and data to your printer from a remote location, PSI|
alowsyou to send email to the printer. Thisis set up under the link POP3 Email
Printing. You need to provide the address of the network POP3 server, a user name,
and a password.
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ZebraNet Utilities
ZebraNet Alert

With this option, you can create atext-based email containing ZPL |1 code and transfer
it to the printer.

@ Note  Email attachments sent to the printer are not supported.

By using the proper ZPL || commands, files can be saved, loaded, printed, copied, and
deleted, just asif the data were transferred from a serial or parallel port.

1 From the Printer Home page, click Print Server Settings.
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The PrintServer page opens.
A http:#110.3.4.102/server{ - Microsoft Internet. .. [I[=] E3

JEiIe Edit “iew Faworites Tools Help

‘<:=,->.@”

Back S Pvatel Stop Refresh

JAgdreSS E

| Links

Focus - ZebraNet PrintServer

-

Status and Configuration
DPrimter
Pnnt Server

Pumt Jobs

Job Log
Cancel Job

Print Server Status
View Confizuration Sheet
Wiew Port Status

Support
Cotitact
FAQ
Updates

Reset
Eeset Printer
Eeset Print Server

Restore
Factory Default Pnnter Sethnes
Factory Print Server Settings

ZebraNet Utilities
ZebraNet Alert

|€| Done I_’_|¢ Internet

RN

2 Fromthe PrintServer page, click Print Server.
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ZebraNet Utilities
ZebraNet Alert

The Print Server Configuration page opens:
A http /10 3.4 1024serverimenu_ht .. =] E3

JEiIe Edit “iew Faworites Tools Help

Back S

\n - = - »jﬂgdress

Links

PrintServer

Focus - ZebralNet

Enabled Protocols
Hetwate
TCPAFP Confimuration
TCP/AF Logical Printing Ports

System (SHLIEY
1P Aletts (Traps

SITE Email Alerts
Wieb A divin
POPS E-Mail Printing

Print Server Configuration

| Home | Print Setwver Config|

Printer Config

[

W’_’_|a Internet

Z

3 Fromthe Print Server Configuration page, click POP3 E-mail Printing.
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ZebraNet Utilities
ZebraNet Alert

The POP3 Printing Configuration page opens:
AR http #1103 4 102}server/POP3 htm - Microsof___ [H[=] 3

JEiIe Edit “iew Favorites Tools Help ‘

j < . =2 @ »JAgdress

Back EarwEnd Stop Refresh

Focus - ZebralNet PrintServer

POP3 Printing Configuration

POP3 Server Address: [0.0.0.0

POP3 User MName: I

FOP3 User Password: I

POP3 Polling Interval (seconds): IU

Submit Changes |

Hoame | Print Sexver Config
Fritter Config

|@ Daone |_|_|¢ Internet

4 Make the necessary changes, and click Submit Changes.

B

ZebraNet Alert monitors status and activity of all Zebra printers on the network. It
aerts the administrator when there is an error condition, which reduces printer
downtime and increases application efficiency.

Open Alert

1 Fromthetask bar, select Start>ZebraNet Utilities>ZebraNet Alert.

2 Inthe ZebraNet Alert dialog, from the menu bar select Report>. The report menu
option has multiple report selections.

3 Select the type of report you want to generate.
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ZebraNet Utilities
ZebraNet Alert

Thisis an example of the Event Summary report. Notice it generatesa. | og file.

[] Fetraket Afert - [Event Summary - Eventl log]
“ File “iew Graph “Windows Help

ER

|aEa s |EE ] = e s e

Ewvent Mame / | Ewent Count |
Paper Out 928
Frinter Off-Line 17
Frinter On-Line 117
Totals 1162

5 Active Log -... [E] Event Summ_,,llLl Evert Sum...l

For Help. press F1
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ZebraNet Utilities
ZebraNet Connect

ZebraNet Connect

For details, see Setting up a ZebraNet Connect | P on page 49.
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ZebraNet Utilities
ZebraNet View Java Applet

ZebraNet View Java Applet

ZebraNet View Java Applet isaJava-based version of ZebraNet View. Thiscan runon
any enabled platform that can run a Java virtual machine, such as Windows, UNIX,

Linux, and many others.

Q Important » To use this, you must haveinstalled it with ZebraNet Utilities and then
installed this application. For installation instructions for ZebraNet Utilities, see

ZebraNet View Java Applet on page 23.

1 From the task bar, select Start>Programs>ZebraNet Utilities>ZebraNet View Java
Applet 1.0.
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ZebraNet Utilities
ZebraNet View Java Applet

Thisview opens:

A} ZebraNet View - Microsoft Internet Explorer |_ O] %]
J File Edit ¥iew Favorites Tools Help |
= &
EreEh eIl Stop Fefresh
| Links

¥
j Address I@ CAProgram Files\ZebraMet, TCRIF Utils\view Java AppletZ ebraMetviewPlugin j

Locate ZebraNet Devices on Network:

IP Address | Serial # | Systerm Mame i&g%

Fearch Method: ILocaISubnet j »¥% Zebra

Address: |255.255.255.255
[ e |5

Begin Search | Help |

Readly... |_ Qpen in Mew YWindow Count: 0

{& ;
¥ Zebra

ZebraNet View Web Configuration Utility

“When opening ZebralTetViewPlugin html, the Web Configuration Applet will load m the top frame of the browser, and this file appears i the lower
frame.

To discovery Zebra network printers on your networle:

1. Select search parameters:

o Local Subnet - broadeast to local subnet (255 255255 255)

o Subnet Broadeast - Enter a subnet broadeast address {e.g 10.10.10.255)

o Wulticast - If your network router support Multicast, just set the Time to Live (Hopcount)

(note: Multicast i not supported on Metscape for all platforms) b

2. Zelect "Begin Zearch” to locate printers
3. Links to Zebra Prnters will be displayed m the lst.
4. Zelect any printer from the st to connect and configure.

N

|8j Applet started. I_I_L_EJ My Computer

2 Inthe Search Method drop-down list box, select the search method you want.
3 Click Begin Search.

It searches your network for al networked Zebra printers, discoversthem, and lists
them.

4 When you select adevice from thelist that is discovered, the selected device's
Home Page displaysin the lower portion of the view (it replaces the ZebraNet
View Web Configuration Utility content).
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Hardware Troubleshooting

This provides you with solutions to known issues.
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Hardware Troubleshooting
Troubleshooting the PSII

Troubleshooting the PSII

Resetting to Factory Defaults

To reset the PSII configuration parametersto the factory defaults, pressthe Test button
and hold it in while turning the printer power on. Keep the test button pressed until the
Status Indicator light turns green, then release the test button. After approximately 20
seconds, a configuration label prints automatically.

Status Indicator

A bi-color Status Indicator displays the operational status of the PSII. The following
conditions might occur:

¢ During normal operation, the LED is solid green for more than 30 seconds. This
indicates all the hardware is functioning properly and it has detected the presence
of the network. It does not mean the PSII has an |P address or is attached to a
printer queue.

o |If the LED israpidly flashing green (9 times/sec), the PSII has not detected the
presence of anetwork cable. To solve the problem:

» Turnthe printer power off. Remove the network cable from the PSII. Plug the
network cable back in until you hear a positive click. Check the other end of
the cable in the same manner. Turn the printer power on. If the PSII still does
not detect a cable, continue.

Q Important « Cables with arating higher than CAT-5 have not been tested.

* Verify that the network cableis 10BASE-T and has an RJ-45 connector.

» Connect the PSII to anetwork drop that is aknown good network connection.
If the PSII is still unable to detect the network cable, contact Technical
Support for assistance.

e |f the LED isslowly flashing green (1 time/sec), the PSII istrying to print ajob. If
the job does not print, check the following:

» Verify that the printer has media and ribbon (if in thermal transfer mode). If
the printer is showing any errors, it isunlikely that the PSII can send datato
the printer. The LED continues to blink until the printer malfunction is
resolved or until the printer is turned off.
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» Flashing red indicates the Power On Self Test (POST) isin progress.

e |f the LED issolid red for more than 30 seconds, the PSII has failed the POST. If
the failureis not severe, the PSII attemptsto print a configuration label on the
printer. A failed POST can be caused by any of the following:

* The printer attached to the PSII device is malfunctioning. Turn the printer
power off, wait 10 seconds, then turn the printer back on.

» If the PSII ill fails the POST, continue below. The PSII has a hardware
problem that can be fixed only by replacing or returning the unit. Contact
Technical Support for repair or replacement information.

e If the LED isalternately flashing red and green for longer than 2 minutes, the PSI|
isin firmware-download mode. This meansit iswaiting for new firmware data to
be sent before it continues normal functioning. Perform the following:

 |f the PSII was purposely put into firmware-download mode, finish the
download with the proper update utility. Contact the Zebra Web site at
http://www.zebra.com to download this utility.

» Contact Technical Support for help recovering this unit.

ZebraNet View Utility Discovery or Configuration Problems

If you are having problems using the ZebraNet View utility to discover or configure
the unit, check the following:

¢ Veify thereis not arouter between the workstation running ZebraNet View and
the PSII. Because the PSII does not have an IP address, TCP/IP communication
cannot be started across arouter. Run ZebraNet View on the same subnet as the
PSII. Thisisnot alimitation when using ZebraNet View for HP JetAdminin IPX/
SPX Discovery Mode.

e Verify the PSII hasasolid green light. If the LED shows arapidly flashing green
light, check the network cable that is attached.

Unable to Print

¢ |f you are having problems printing, verify that there is communication between
the PSII and the printer. Check the following:

» Print aconfiguration label by pressing the test button on the PSII. If a
configuration label does not print, verify the printer has media and ribbon (if
used) and is not paused.

» |If problems persist, contact Technical Support.
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Unable to Configure Device

To assign an | P address to a ZebraNet PSII using ZebraNet View, you must be on the
same subnet. If ZebraNet View has Multicast enabled, you might be able to view the
ZebraNet PSII on another subnet, but you will not be able to configure the device.

HP JetAdmin or HP Web JetAdmin

The ZebraNet PSII might be set up and managed using HP JetAdmin or HP Web
JetAdmin products.
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Frequently Asked Questions

Thisisagroup of frequently asked questions (FAQs) about PSII.
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FAQs

Thistable provides frequently asked questions (FAQs) on PSII:

Question

Arethere any differencesin
functionality between a ZebraNet
PSII with an EPL -based printer
and with a ZebraL ink-enabled
ZPL printer?

‘ Answer

Yes.

e In aZebralink environment, with either a
Web browser or with the ZebraNet View
Utilities, there are a variety of Web pages
that display awealth of status information
regarding both the ZebralLink printer and
its ZebraNet PSII. However, when used
with an EPL printer, such asthe LP/TLP
2844, the Web pages for printer status are
not available at this time, only the Web
pages showing status of the PSII are dis-
played. The PSII can be easily configured.
However, printer configuration information
regarding the EPL printer is not available
viathe ZebraNet Utilities.

e Error conditions. Using ZebraNet Alert, an
EPL printer can be configured to use differ-
ent | P addresses to report the following
Alert status conditions: on-line, off-line,
paper out.

e For EPL: only two destinations can be con-
figured to report error messages (online,
offline, and paper out) using SMTP emall
alert — serial and parallel port destinations
are not supported.

Can theinternal ZebraNet PSII
option work on a computer
network that isrunning both
TCP/IP and IPX protocols
simultaneously?

Yes.

The ZebraNet PSII runs all of itsavailable
protocols simultaneously. Thismeansthat the
ZebraNet PSII can run on mixed networks
such as a network using Microsoft, UNIX,
and Novell NetWare operating systems.
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Question ‘ Answer

Will the ZebraNet PSII allow Yes.

connectivity to anything other The ZebraNet PSII allows connectivity to

than a PC network? systems such as |BM’s AS400, provided that
it is configured using TCP/IP. Other network
protocols can be used with third-party
adapters that are converted to 10BA SE-T.

Will the ZebraNet PSII option No.

work on a I0BASE-T per second  1he 7ehraNet PSII option is a 10BASE-T

network? print server. This means that the data cannot
travel any faster than 10 megabits per second.
The ZebraNet PSII can be deployed on a
network that is utilizing 10/100 hubs, but the
ZebraNet PSII operates at only 10 megabits
per second.

What if aprint job makesit to These are the things to check:
the queue, but never leavesthe

. e Confirm that the printer is turned on and
gueue? Thelabel doesnot print.

receiving power.

¢ Confirm that the network cable is plugged
in and that you can ping the printer.

If the above bullets do not change the
outcome, it islikely that there was a
misconfiguration while creating the queue.
The queue must be recreated verifying the
following:

e Confirm that you use the print server’s
valid IP address.

e |f you are using aUNIX or AS/400
host, there is an option for the remote
gueue name. Thereisonly onevalid
response to use: PORTLF1.

¢ |f Windows does not have LPR
installed, the above required option
should be left blank.

¢ See the documentation for other oper-
ating system specific queue creation.
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What are the minimum e Cat-5 network cable with 10BASE-T con-
requirementsto network a nectors
printer? e PSII

¢ Hub or Switch

e |f ahub or switchisNOT used, you need a
cross-over cable.

¢ Workstation running a TCP stack with print
servicesinstalled

What do the activity lightson the e Fast blinking (9 times/second)—no link
PSII mean? status

e Slow blinking (1 time/second)—no IP
address, or the unit is sending data to the
parallel port

e Blinking red—unit is still in POST

e red-green-red-green—unit isin Netware
firmware update mode

e red-red-green-green—unit isin [P firm-
ware update mode

e Solid red—unit has failed POST. Remove
network cable and restart printer

What isthe default User ID and e The User ID isadmin and the password is
password for the print server? 1234.
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Question ‘ Answer
What portsareopen on PSIl and TCP Ports:
related software? e 21 ETP

e 23 Telnet

e 8OHTTP Server

¢ 515 Printer port

e 631 | PP port

¢ 9100 Raw socket connection

UDP Ports:

¢ 161 SNMP broadcast from PSII

¢ 162 SNMP trap on ZebraNet Alert
e 4201 discovery destination on PSII

e (dynamic) SNMP get request from Zebra-
Net View

e (dynamic) discovery broadcast from Zebra-
Net view

e (dynamic) discovery broadcast from Zebra-
Net view Java
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Question ‘ Answer

What are my network It depends on your environment, but the print
connectivity options based on server accepts print jobsin any of the

when using a PSI17? following ways:

e FTP—ZPL/EPL files can be sent to the
printer viaaFTP client as standard ASCI|
files

o HTTP—(ZebralLink-enabled printers only)
Using the script option of the print server’s
homepage, you can type ZPL into a speci-
fied location of the Web browser and send
it to the printer

e |PP—Using third-party IPP clients, print
jobs can be sent viathe internet

¢ L PR/ILPD—Sometimesreferred to as queue
based printing. LPR/LPD isthe standard in
network printing. Most TCP/IP operating
systems are compatible with this option

e Raw socket connection—You can connect
to the printer directly viathe network,
bypassing everything in-between. This
option is commonly used to integrate ZPL/
EPL into existing programs, such asVB
scripts

e POP3—With proper configuration, you can
place ZPL/EPL filesinto the body of an
email, and it will print. The print server
periodically checks this email box at the
specified intervals and prints the body of
the message. IMPORTANT: attachments
and subject line are not supported
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10BASE-T A type of Ethernet that uses unshielded twisted pair cable.

arp The standard TCP/IP method for determining the actual network address of a
device based on its | P address.

ASCIl A standard for the binary representation of characters.

BOOTP BOOTP (Bootstrap Protocol) is a protocol that lets a network client
configure automatically. It can automatically configure any of the following
information: 1P address, gateway, subnet, system name, name server, and more. It
automatically assigns the necessary settings from a pool of pre-determined addresses
for acertain duration of time. BOOTP isthe basis for a more advanced network
manager protocol, the DHCP (Dynamic Host Configuration Protocol).

broadcast In anetwork, a situation when all destinations on the network receive a
given packet.

client A workstation or PC in aclient/server environment.
community For SNMP, arelationship between an agent and a set of SNMP

managers that defines security characteristics. The community concept is alocal one,
defined at the agent. Each community is given a unique community name.
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DHCP (Dynamic Host Configuration Protocol) DHCPisan aternativeto
another network |P management protocol, Bootstrap Protocol (BOOTP). Like
BOOTPR, DHCP can configure an | P address, gateway, subnet, system name, and name
server. When speaking about the PSII, BOOTP, and DHCP configure the same
options.

delete bytes Thisnumber isused to remove characters from the beginning of every
job sent to the logical printer. The value for delete bytes can range from O to 255.

dynamic A dynamic configuration, as the name implies, meansthat it changes.
BOOTP and DHCP offer time-based |eases for the configurations they assign. Their
changes depend on the time-based |ease, and how often the printer itself is offline and
online again. A dynamic configuration includes BOOTP or DHCP.

EPL Eltron Programming Language.

Ethernet A widely used local area network system based on the |EEE 802.3
standard.

firmware Software routinesthat are stored in ROM (Read Only Memory). Thisis
typically part of adevice, such asaprinter or PSII.

FTP File Transfer Protocol, a TCP/IP-related protocol for transferring files between
devices on a network.

Flash memory A type of memory that allows read-and-write operations, but
permanently stores data when the power isturned off. Useful for storing firmware
because it can be easily updated by downloading new code.

gateway A devicethat converts one higher-level network protocol to a different
higher level protocol.

gleaning A temporary, local configuration option. Gleaning lets you add the address
of the device you want to configure to your local workstation’s arp table. This
configuration is not permanent and is valid only from the workstation from which you
entered the arp information. After the information is entered into the workstation’s arp
table, the user follows up with a Telnet session to enter the information permanently.
This configuration option is used mostly by non-Windows workstations that cannot
run the ZebraNet View configuration utility.

IP Internet Protocol, one of the main protocols of the TCP/IP protocol suite.
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IP address A network address used by the TCP/IP protocol.

IPP Internet Printing Protocol. Allows you to associate a printer with a URL address
that is used for printing over the Internet.

IPX Internetwork Packet Exchange, one of the NetWare protocols.

JetAdmin A Hewlett-Packard printer management program available for NetWare
and TCP/IP.

logical Refersto conceptual rather than physical. For example, a computer might
have a single physical connection to the network (an Ethernet adapter card), but could
have logical connections to several other devices on the network.

MAC Address MediaAccess Control. Ethernet address that corresponds to the
assigned | P address.

name server A workstation on a TCP/IP network that provides alist of all
workstations on the network.

NetWare A network operating system developed by Novell.
node A device connected to a network, such as a computer or print server.

parallel port A port on adevice that sends information in groups of bits over
multiple wires, one wire for each bit in a group.

ping A TCP/IP command that determines whether a device is accessible on the
network.

POP3 Post Office Protocol, the protocol used to retrieve email from the server.

port A physical connector, such asthe parallel port, or alogical connection to a
device.

post string A string that is sent at the end of every job going to the logical printer.
Maximum 64 characters long.

pre string A string that is sent at the beginning of each job that goes to the logical
printer. Max 64 characters long.
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print server A devicein anetwork that changes a network protocol into a printer
protocol.

protocol A method of sending and receiving data between two or more workstations
on a network, and insuring that the data is received without errors.

rarp Reverse Arp, astandard TCP/IP method of determining adevice's IP address
based on its Ethernet address.

raw TCP port A type of TCP port in which datais passed unmodified to the
receiving node.

RJ45 A type of modular jack connector similar to a telephone connector with up to
eight wires. Used for 10BASE-T Ethernet connections and for serial port connections.

serial port On aprinter or print server, aport that transfers data one bit at atime.
Serial ports usually have either a 25-pin, 9-pin "D", or RM45 connector.

server A deviceonalocal areanetwork that provides servicesto client computerson
the network.

SMTP Simple Mail Transfer Protocol, a protocol used to send email messages over
the Internet.

SNMP Simple Network Management Protocol, a protocol for monitoring and
controlling devices on anetwork.

spooling In printing applications, spooling is the transfer of data to atemporary
storage area on disk (the print queue) prior to printing. Spooling alows many jobs to
be queued to a single printer.

static Refersto adtatic IP address. All information is provided by the network
administrator.

subnet mask A TCP/IP method of dividing a network into several smaller
subnetworks.

TCP/IP Transmission Control Protocol/Internet Protocol, the de facto standard for
Internet communications that is widely used on local area networks.

TCP Port A method of accessing a TCP/IP service, where a device with asingle IP
address can have multiple TCP ports.
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Telnet A TCP/IP protocol that allows two devices to communicate over a LAN.

trap An unsolicited message sent by an SNMP agent to an SNM P management
station. It notifies the management station of some unusual event.

UNIX A general-purpose computer operating system used on many different kinds of
computers.

WCSO Wireless Card Socket Option. Zebra's wireless Ethernet option.

Windows 95 and Windows 98 Microsofts PC operating systems that feature
built-in peer-to-peer networking.

Windows NT Microsofts multitasking operating system that can be used either asa
client or as a server.

Windows 2000 Microsofts multitasking operating system that replaces Windows
NT; can be used as either as aclient or as a server.

ZebraNet PrintServer Il An Ethernet connectivity solution.

ZebralLink Allowsyou to connect and control your bar code printers anywhere and
anytime.

ZPL Il ZebraProgramming Language Il is a powerful label-definition and printer-
control language.
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